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Using This Guide

This user guide provides instructions for installing, operating and maintaining 
Stratasys J850/J835 3D printing systems. It explains how to use features, and 
provides practical examples to guide you as you use the system.

Important: Read the entire Safety chapter before using the system. 

The text and figures in this guide are based on the J850 3D printer, software 
version D41.1 - 85.2.0 .

This guide assumes that—

• all the hardware, software, and network components of your  system are 
installed, configured, and operating correctly.

• the operator has a working knowledge of the Windows® PC platform.

For More Information

Visit the Stratasys Support Center to download the latest revision of this 
document.This document is also available on the Support Center in other 
languages.

If you have any questions or comments about the way information is presented 
in this guide, or if you have any suggestions for future editions, please send a 
message to c-support@stratasys.com.

 

https://support.stratasys.com/
mailto:c-support@stratasys.com
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Revision History

Translations of this guide are updated periodically. If you are consuming a translated 
version, please check the English version for the latest revision and list of updates.

The following table lists the main changes in each revision of this document.

Revision Release Date Description
Rev. E December 2020 • About this Guide was updated.

• Additional Resources was added.
• Changing the Printing Material was 

updated.
• Replacing the Odor filter was updated.
• Improving the Color of X-walls was added.
• Setting the Cartridge Expiration Date was 

added.
• Cleaning the Print Head, Roller, and Wiper 

was updated with cleaning the UV glass 
lenses instruction.

• Aligning the Print Heads was updated.
• Minor text and style corrections.

Rev. F January 2021 • Additional Resources was updated.
• Workstation Requirements was updated.
• Replacing the UV Lamps was updated with 

instructions for replacing the UV lamp bulb.
• Photobleaching for Transparent Parts was 

updated.
• Cleaning the Print Heads, UV Glass, Roller 

and Wiper was updated with a note to 
empty the waste container before starting 
the wizard.

•  Shutting Down the Printer was updated 
with a note to empty the waste container 
before starting the wizard.

• Optimizing the Print Heads was updated 
with a note to empty the waste container 
before starting the wizard.

• Text, style and format improvements.

Rev. G February 2021 • Improving the Color of X-walls was updated.
• Text, style and format improvements.

Rev. H July 2021 • Preparing the Build Tray for Printing on 
Fabric was added.

• Adjusting the Build Tray Height was added.
• The terms model, part, and object were 

replaced with the term 3D print  throughout 
the guide.
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Terms Used in This Guide

Build tray In the print preparation application: The surface displayed on the screen 
that represents the actual build tray in the printer.
In the printer: The substrate for 3D printing.

Cleaning fluid Cleanser for flushing material feed tubes and the printing block, used to 
completely remove model and support material from the system before 
loading another type of material in the printer and before long-term 
shutdown. The cleaning fluid is supplied in material cartridges.

Client/user 
workstation

The workstation on which  software is installed for preparing build trays 
for production on PolyJet printers. (There is no limit to the number of 
client workstations.)

GrabCAD Print A software application for preparing print jobs on a variety of 3D printers, 
including J850/J835 printers.

Mixed part 3D prints that are produced using more than one model material.

Mixed tray A build tray containing 3D prints, each designed to be printed using a 
different model material.

Model material Material used for building the 3D prints.

Printer 
computer

The computer inside the J850/J835 printer that operates it.

Printer 
interface

The GUI (graphical user interface) used for controlling J850/J835 
printers.

Printer 
software, 
printer-control 
application

Software running on the computer in the J850/J835 printer, controling all 
printer operations.

Resin The base substance from which photopolymer printing materials are 
made for use in Stratasys PolyJet printers.

STL A file used for printing 3D models.

Support 
material

Material used for supporting the structure of models during production.
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Additional Resources

Stratasys encourages you to learn more about your additive manufacturing 
printer, its capabilities and the technology. A wealth of information is available 
on our online digital platforms.

Stratasys Academy

Stratasys Academy is your online learning platform. Here you can browse our 
extensive and growing course catalog, register to webinars, view  tutorials and 
videos at your own pace, and enroll in face-to-face, in person courses. We 
encourage you register and start your leaning journey today.

 

https://stratasys.plateau.com/learning/user/portal.do?siteID=CUSTOMERS&landingPage=login
https://support.stratasys.com/Academy Registration
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Stratasys Support Center

The Support Center is your portal to thousands of knowledge assets, including 
information on design, applications, and materials. The site also has links to 
Web-based training, "how-to" videos and the Stratasys blog. In addition, you 
can check the latest revision of the user guide for your printer, and download 
documents in different languages.

The Support Center is available in multiple languages. You can change the 
display language using the language drop-down menu in the top-left corner of 
the homepage. 

 

GrabCAD Community

The Tutorials section of GrabCAD Community portal is a valuable source for 
Stratasys-sponsored and user-genertated 3D printing tips. You can also ask 
3D-related questions on the portal and download free CAD files.

http://support.stratasys.com/
https://grabcad.com/tutorials
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Safety Features

Stratasys 3D printers are designed to comply with CE and FCC 
standards. They are equipped with the following safety features:

Interlock Switch
The power supplied to the UV lamp, the tray heater and the 
motion motors is turned off when the cover is opened.

Warning
Do not defeat (override) the interlock switch. Doing so could 
result in serious personal injury. If the interlock switch does not 
function correctly, do not use the printer, and contact your 
service provider.

Safety Lock
The cover is locked while the printer is working. If you do 
manage to lift it, the UV lamps and the motion motors turn off.

Warning
Do not defeat (override) the safety lock. Doing so could 
result in serious personal injury. If the safety lock does not 
function correctly, do not use the printer, and contact your 
service provider.

UV Screening
The transparent section of the cover blocks harmful UV 
radiation, allowing the operator to view the 3D prints during the 
printing process.
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Figure 2-1 Front view of the  printer

Circuit Breaker
The power to the printer is turned off in case of electrical 
overcurrent. 
Note: The circuit breaker is only accessible to service 
personnel.

UV-Lamp Overheating 
Protection

The power supplied to the UV lamp and the motion motors is 
turned off if the temperature around the lamp reaches 90°C 
(194°F). A label on the UV-lamp cover indicates if the 
temperature has exceeded 65°C (150°F).

 

Grounded Chassis
The chassis of the printer is grounded, to prevent electrical 
shock.
Note: The power outlet must be grounded in accordance with 
the local electric code to provide this protection.

If the printer is not used as specified in this guide, these safety features may not 
provide adequate protection.
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Symbols and Warning Labels

The following table lists the warning labels located on or in the printer.

Warning Symbol Meaning Location Comments
Hazard (general) On the name plate on 

the back of the printer.
Read the instructions in 
this document before 
operating the printer.

Hot surface On the print block. Risk of burns. Do not 
touch this surface after 
printing.

High voltage Near the UV lamp 
connectors.

Near the power-supply 
enclosures.

Risk of electric shock. 
Disconnect the power 
before servicing.

Ultraviolet radiation

 

Near the UV lamps.

 

Risk of injury to skin and 
eyes from ultraviolet 
radiation. Disconnect the 
power before servicing.
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Safety Guidelines

The following general guidelines, together with the instructions provided 
throughout this user guide, ensure user safety while operating and maintaining 
the system. If the system is not operated as specified, the user's safety 
may be compromised.

Printer Installation

➢  Installation and removal of the printer should only be done by qualified 
service personnel. 

➢  Connect the printer (and the UPS unit) to the electric outlet using a power 
cable that is safety-certified.

➢  The electric outlet should be easily accessible, near the printer.

➢  Never connect the power plug to an outlet that does not have a ground 
(earth) wire, and never disconnect the ground. Doing so might expose the 
operator to serious danger from electric shock.

➢  The following safety statement is followed by translations to Finish, 
Norwegian, Swedish and Danish, as required by local regulations: 
“The machine must be connected to a grounded power outlet.” 

❒  FI: Laite on liitettävä suojakoskettimilla varustettuun pistorasiaan.
❒  NO: Apparatet må tilkoples jordet stikkontakt.
❒  SE: Apparaten skall anslutas till jordat uttag.
❒  DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som 

giver forbindelse til stikproppens jord.

➢  Leave a minimum of 15 centimeters (6 inches) between ventilation 
openings and walls or other objects.

➢  For Japan: The power cable supplied is provided for connecting the printer 
to the AC electric source. Do not use it with other equipment.

Printer Operation

➢  The printer should only be operated by persons trained by an authorized 
Stratasys representative.

➢  All persons operating or maintaining the printer should know the location of 
first aid and emergency equipment and how to use it. Never block access 
to this equipment.

➢  Keep fingers and other body parts clear of the printer when closing the 
cover.

➢  Never attempt to open the printer while it is working.

➢  Never override the interlock safety switch.

➢  If the interlock safety switch ever fails, do not use the printer. 
➢  Several parts of the printer remain extremely hot even after it has stopped 

operating. Avoid touching the UV lamps and the print block. 
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UV Radiation

The UV lamps used in the printer emit dangerous radiation

➢  If the UV lamps remain on when the printer is open, do not stare directly at 
the UV light. Shut down the printer and call your Stratasys service provider.

Printer Maintenance

➢  Service operations should be performed only by qualified personnel who 
have been instructed in relevant safety precautions.

➢  Notify co-workers and those who have access to the printer before 
beginning non-routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety 
officer or to other appropriate authorities.

Model and Support Materials

Model and support materials are made of chemical substances. Although 
precautions must be taken when handling these materials directly, all model 
and support materials used by the printer are handled in sealed cartridges. 
Normally, operators of the printer should never be directly exposed to 
hazardous materials. In the unlikely event of a leak or spill, follow the 
instructions that are included with the material cartridges used.

➢  Store model and support materials indoors, in a dry area with adequate 
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit). 
Never expose them to flames, heat, sparks, or direct sunlight.

➢  Keep model and support materials away from areas where food and drink 
are stored, prepared and consumed.

➢  Uncured printing material is considered a hazardous substance, requiring 
certain precautions when directly handling it. To prevent skin irritation, wear 
neoprene or nitrile gloves. If there is any chance that model and support 
materials might splash into the eyes, wear safety goggles. Prolonged direct 
contact with printing materials can cause an allergic reaction.

➢  When handling UV-cured 3D prints that may not be completely cured on the 
surface, common latex gloves are adequate. 

➢  To prevent respiratory irritation, ventilate areas where model and support 
materials are used. If the printer is not equipped with an exhaust duct, the 
room ventilation system should replace the air 4–6 times per hour.

➢  Clean up model-material and support-material spills with disposable towels 
or other absorbent, non-reusable material, such as sawdust or activated 
charcoal. Rinse the spill area with denatured or isopropyl alcohol (IPA), 
followed by soap and water. Dispose of the absorbent material in 
accordance with local regulations.

➢  Do not wash contaminated clothing at home; clothing should be 
professionally laundered.
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➢  Dispose of contaminated shoes, belts and other leather items in 
accordance with any applicable regulations. Absorbed printing material 
may re-expose the user when these items are worn.

UV Lamps

UV lamps used by the printer to cure printing materials contain a small amount 
of mercury. In the unlikely event of lamp breakage, avoid inhaling mercury 
vapor, and ventilate the room. If the lamp ruptures (breaks) during operation, 
leave the room and ventilate it thoroughly for about 30 minutes. 

Use protective gloves to prevent contact with mercury and other lamp 
components. Carefully remove spilled mercury with a method that prevents the 
generation of mercury vapor, such as a syringe, packing tape or paper. 

Place the broken lamp, mercury and contaminated materials in an air-tight, 
non-metallic container. Dispose of the container in accordance with applicable 
regulations.
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First Aid for Working with Printing Materials

In general, try to avoid direct contact with uncured printing material. If skin or 
eyes come into contact with it, wash the area immediately and thoroughly with 
water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing 
materials contains important safety information. Keep this in an accessible 
place where these materials are used and stored.

Contact with Skin

If uncured printing material comes in contact with skin, wash the affected area 
immediately and thoroughly with soap and cool water, then remove 
contaminated clothing. Pay particular attention to flushing the hair, ears, nose 
and other parts of the body that are not easily cleaned. 

➢  Use cool water to prevent skin pores from opening, so that the liquid 
material does not easily penetrate the skin. 

➢  Do not use solvents to clean skin. 

➢  If large areas of skin have been exposed, or if prolonged contact results in 
blisters, seek medical attention. In any case, if irritation persists, seek 
medical attention. 

➢  Avoid the accidental transfer of printing material from the hands to other 
areas of the body, especially to the eyes. 

➢  If protective cream was used, do not reapply it until the skin has been 
completely cleansed. 

Contact with Eyes 

If uncured printing material comes in contact with the eyes, flush immediately 
with large amounts of water for 15 minutes and seek medical attention. 

➢  Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation. 
Wearing contact lenses when handling liquid printing materials is not 
recommended. If the liquid splashes into the eyes when contact lenses are 
worn, immediately remove the lenses and flush the eyes with water. 

➢  Clean and disinfect the contaminated lenses. 

➢  Do not wear contact lenses until eye irritation disappears.

Ingestion

If printing material is swallowed, refer to the instructions included with the 
cartridge. Seek medical attention immediately.
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Inhalation

Vapors from printing materials can be irritating to the respiratory system. If 
respiratory irritation occurs, expose the victim to fresh air immediately.

➢  If the victim has stopped breathing, perform artificial respiration or 
cardiopulmonary resuscitation. 

➢  Seek medical attention immediately.

➢  Keep the victim warm but not hot. 

➢  Never feed anything to an unconscious person.

➢  Oxygen should be administered by authorized personnel only.

Waste Disposal 

Fully cured 3D prints can be disposed of as ordinary office trash. However, 
special care is required when handling printer waste (uncured printing 
material).

Printing Materials

➢  When removing the waste cartridge/container from the printer, wear 
neoprene or nitrile gloves.

➢  To prevent liquid waste from splashing into the eyes, wear safety goggles.

➢  Liquid waste from the printer is classified as hazardous industrial waste. 
Therefore, printing-material waste must be packaged and disposed of in a 
manner that prevents human contact with it and contamination of water 
sources.

➢  Empty model-material and support-material cartridges contain residue of 
their contents. Some leakage of this residue may occur through the broken 
cartridge seal. Therefore, handle and store empty cartridges with care. 

➢  Do not attempt to reuse empty cartridges, and do not puncture them.

➢  Dispose of used cartridges and waste containers in accordance with local 
regulations.

➢  Discard contaminated clothing, shoes, empty containers, etc., in 
accordance with any applicable regulations.
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UV Lamps

UV lamps used by the printer to cure printing materials contain a small amount 
of mercury, and are considered “Universal Waste.” Recycle or discard used 
lamps in accordance with applicable regulations.

Broken lamps: 
After ventilating the area, use protective gloves and carefully remove spilled 
mercury with a method that prevents the generation of mercury vapor, such as 
a syringe, packing tape or paper. Place the broken lamp, mercury and 
contaminated materials in an air-tight, non-metallic container. Dispose of the 
container in accordance with applicable regulations.
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Basic Features

Stratasys J850/J835 printers offer the following options:

• You can streamline and economize the process of producing 3D prints.
❒  Producing 3D prints made from different materials on the same build 

tray (“mixed tray”), in the same print job, eliminates the time-consuming 
need and expense of loading another material, flushing the system, and 
sending a separate job to be printed.

❒  Alternating print jobs that use any of the model materials (or material 
combinations) loaded similarly does not require material replacement—
again, saving time and expense.

• You can print objects with combinations of basic materials (digital 
materials), enabling you to choose from a wide range of possible 
mechanical properties—from flexible to rigid. 

• You can print parts (shells) of the same part—simultaneously—with 
different materials (or material combinations)

• You can produce 3D prints that have a “coating” made from a different 
material than the main part of the 3D print.

• You can mix any combination of base materials, resulting in an extremely 
wide range of available colors. 

• If you designate colors for parts of a 3D print at the design stage (with CAD 
software) and save it as a VRML file, the parts are automatically assigned 
appropriate material combinations in GrabCAD Print for production with the 
desired colors.

• You can choose the preferred support material for your needs.
GrabCAD Print supports many 3D CAD file formats, eliminating the need to 
convert them to STL files. GrabCAD Print can also repair damaged files before 
sending them to the printer.
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Work Configurations

Stratasys J850/J835 3D printing systems can be set up as single-station 
systems or as multi-station systems. When connected to a local computer 
network, the system can serve multiple users. In such configurations, each 
user (client) prepares files  for production. A software service, installed on the 
printer computer, processes jobs and controls the printing.

Figure 3-1 shows the printer set up in a multi-client configuration.

Figure 3-1    Multi-client network configuration
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Source Files

Stratasys J850/J835 printing systems produce 3D prints designed with most 
CAD tools and some other 3D applications. 

GrabCAD Print supports STL, VRML, OBJ and 3MF files. In addition, 
GrabCAD Print supports native CAD formats from these programs: Creo, 
SOLIDWORKS, NX, CATIA and Inventor. To see the complete list of file 
formats supported by GrabCAD Print, go to: help.grabcad.com/print/file-
formats.

J850/J835 systems feature the capability of producing different types of  files 
simultaneously.

 

http://help.grabcad.com/print/file-formats
http://help.grabcad.com/print/file-formats
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Printing Materials

Stratasys J850/J835 printers produce 3D prints by jetting thin layers of printing 
materials on the build tray, until the complete 3D print is formed. Two types of 
material are used in this process:

• Model material—which makes up the finished 3D print.

• Support material—which fills gaps and spaces in the part during printing, 
and is removed after printing.

For up-to-date information about PolyJet printing materials and their 
properties, go to www.stratasys.com/materials/polyjet.

Storage

Materials used for producing 3D prints with J850/J835 printers are made of 
resins, which are composed of reactive monomers and oligomers. Although 
printing materials are supplied in sealed, UV-proof cartridges, care must be 
taken when storing and handling them. Follow these guidelines to protect 
operators and the environment, and to ensure optimum results. 

• To ensure product stability, do not allow these materials to come into 
contact with metal. Plastics made from monomer-soluble substances (such 
as polystyrene or polyvinyl chloride) are not suitable for storing PolyJet 
printing materials.

• When not in use, keep material cartridges tightly sealed to prevent 
contamination, the effects of exposure to UV radiation, and accidental 
spillage.

• Store material cartridges indoors, in a dry area with adequate ventilation, 
between 15–27 degrees Celsius (59-81 degrees Fahrenheit). If exposed to 
heat or flames, cartridges might burst or ignite.

• Signs of premature polymerization in material cartridges include bulging, 
leaking, the emission of heat, and unusual odor. Exposure to heat can 
cause resin to gel in the cartridges.

• Make sure that material cartridges are stored in accordance with all local 
regulations and other applicable requirements.

Shelf Life

Materials used for producing 3D prints have a limited shelf life. The expiry date 
on the label is valid when properly stored in an undamaged, unopened 
cartridge. Always rotate your stock, so that the cartridge with the earliest date 
is used first.

Exposure to Light

If printing materials are not in their sealed cartridges, make sure to shield them 
from sunlight and other sources of UV radiation, such as fluorescent and 

http://www.stratasys.com/materials/polyjet
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mercury-vapor lights. Exposure to UV radiation causes an increase in viscosity 
and, eventually, solidification.

Safety Considerations

Before being cured, resins are hazardous materials. To prevent possible 
health hazards, follow these precautions regarding printing materials: 

• Do not expose to flames, heat or sparks.
• Prevent contact with skin and eyes.
• Ventilate areas where they are handled. 

• Keep them separate from food and drink.
Cured plastic parts, however, are safe. They can be handled and stored 
without precautions.

You can find more safety information about resins in:
 l "Safety Guidelines" on page 2-5
 l "First Aid for Working with Printing Materials" on page 2-8

Disposal

Dispose of cartridges of model and support material in accordance with all 
applicable laws and regulations. 

Work Environment

Extreme heat and humidity conditions can adversely affect the operation of 
your J850/J835 3D printer. Use ventilation or air-conditioning systems, if 
necessary, to keep the work area within the following ranges:

• 18°–25° C (64°–77° F)
• 30%–70% relative humidity

Workstation Requirements 

GrabCAD Print is an application for preparing and managing print jobs on 
Stratasys J850/J835 printers (and on other supported 3D printers). 

• To download GrabCAD Print, go to: help.grabcad.com/print/sign-up. 

• To see the requirements for client computers running GrabCAD Print, go to: 
help.grabcad.com/print/system-requirements.

http://help.grabcad.com/print/sign-up
http://help.grabcad.com/print/system-requirements
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Figure 4-1    The Stratasys J850/J835 3D Printer

Starting the  Printer

Caution
 l Do not attempt to operate the printer before being trained by an authorized 

Stratasys representative.
 l Observe all safety warnings and follow the safety guidelines described in 

Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 4-2    Main power switch and cable
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The main power switch turns on the J850/J835 printer, which includes the 
built-in computer. 

2. After the printer-control computer boots, log in to Windows and launch the 
printer-control program:
❒  On the printer-computer desktop, double-click the J850/J835 printer 

icon.
or—

❒  From the Windows Start menu, select (All) Programs > Objet > 
J850/J835.

A HASP plug containing a valid product activation key is required on the 
printer computer. This is supplied during printer installation or upgrade. If 
the application does not open and a HASP message appears, contact your 
Stratasys dealer or service provider.

All monitoring and controlling of the printer is done from this interface.

Figure 4-3    Printer interface
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Loading Model and Support Cartridges

The number of material cartridges loaded in J850/J835 printers depends on 
the active printing mode.

• In High Mix / High Quality mode, you can use up to 14 cartridges of model 
material and two cartridges of support material. 

• In High Speed mode, you can use three or six (3/6) cartridges of model 
material and one or two (1/2) cartridges of support material.  

• In Super High Speed mode, you can use two or four (2/4) cartridges of 
model material and two or four (2/4) cartridges of support material. 

A graphical representation of the cartridges loaded and their current weight 
appears in the printer interface (see the figure on the previous page).

The material cabinet contains a module that identifies loaded printing 
materials. Tampering with this module will render the printer inoperable and 
may void Stratasys warranties and service contracts.                 

Important: If you need to replace the printing material currently installed with 
another type, see "Changing the Printing Material" on page 4-21. Otherwise, 
make sure to replace the material cartridge with one containing the same type 
of material.

To load model and support material:

1. Open the material cabinet.

2. Load model and support cartridges into their respective compartments.
You should feel some resistance, as a needle pierces the cartridge seal. 

3. Check the printer interface to make sure that the new cartridge is detected 
and that its weight is displayed (see the figure on the previous page).

4. Close the material cabinet.

Tips about loading and replacing material cartridges:
 l You can replace material cartridges either before or during printing. 
 l You can load partially used cartridges, provided that they contain more than 

100 grams of material.
 l You can replace a partially used cartridge to avoid the need for replacing it 

during printing. 
 l The cartridge type is automatically detected by the printer. If you replace a 

cartridge containing different model material, a message appears 
recommending that you run the Material Replacement wizard to flush out 
the old material.

 l If printing stops for an extended time before you replace a material 
cartridge, the printer may go into Standby or Idle mode. If this happens, see 
"Resuming Production After Printing has Stopped" on page 4-18.

../../../../../Content/6_Topics_Printer/Printer_Interface_Screen.htm
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Producing 3D Prints

3D prints can be produced after they are arranged on the virtual build tray in 
the GrabCAD Print application. For information about preparing files for 
printing, see the GrabCAD Print online documentation.

Preparing the Printer

Before beginning to produce 3D prints, it is recommended that you check the 
current printing quality of the print heads by performing the Pattern Test.

To prepare the printer for printing:

1. Make sure that the build tray in the printer is empty and clean.

2. If not, lock the build tray and remove cured material with the scraper, and 
clean the tray thoroughly with a cleaning cloth soaked with 90% alcohol 
(IPA or ethanol). To lock the buidl tray

Caution
Use protective gloves when cleaning the build tray, and be careful of the 
sharp edges of the scraper blade.

3. Make sure that there is sufficient model and support material loaded, as 
indicated on the printer interface (see the figure on page 4-4). You may 
want to replace the cartridges of model and support material currently 
loaded in the printer to avoid the need for replacing them during printing.

Note: When you click Print in GrabCAD Print, a warning message appears if 
there is not enough of one or more material.

For loading material cartridges and replacing empty ones, see "Loading 
Model and Support Cartridges" on the previous page.

For changing the type of material currently loaded, see "Changing the 
Printing Material" on page 4-21.

http://help.grabcad.com/collection/189-print
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You can monitor printer status by switching the printer interface display. To do 
this, click the display toggle button on the printer interface screen.

Figure 4-4    Printer status
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Preparing the Build Tray for Printing on Fabric

For J850 3DFashion printers, before printing on fabric, you need to place the 
fabric on build tray, secure it with the frame, and make sure that it is stretched 
properly across the tray.  

To prepare the fabric on the tray:

1. Prepare—
❒  a square piece of fabric with the following dimensions:

• Size: 510 x 410 mm 

• Thickness: 0.5–2 mm
❒  a plastic ruler

2. Make sure that the fabric is not wrinkled. If necessary, iron it.

3. Remove the frame from the build tray. Lift it using the magnet release 
levers.

Figure 4-5    Magnet release lever on the frame

4. Place the piece of fabric on the tray and make sure that there is 
approximately 1 cm of excess material on all sides of the tray.

Note: If you are printing on mesh, place a sheet of baking paper with the 
same dimensions as the mesh on the tray and place the mesh on top of it. 
Do not use wax paper. The wax melts during printing and can damage the 
print.

Figure 4-6    Placing the fabric on the tray



Stratasys J850/J835 User Guide 4 Operating and Maintaining the Printer

DOC-18001 Rev. H 4-9

5. Place the frame on the build tray and fold the magnet release levers into 
their slots.

Important:
To avoid damage to the printer, always make sure that the magnet release 
levers are folded in their slots.

6. Remove any ripples in the fabric by pulling and stretching the edges of the 
fabric from under the frame. Make sure the fabric is pulled taut and  tightly 
stretched across the tray.

Figure 4-7    Stretching the fabric on the tray

7. Using a plastic ruler, tuck (push) the edges of the fabric into the gap 
between the build tray and the surrounding area.

Figure 4-8    Tucking the edges of the fabric into the gap



Stratasys J850/J835 User Guide 4 Operating and Maintaining the Printer

DOC-18001 Rev. H 4-10

Adjusting  the Build Tray Height

Fabrics have different thicknesses and different tensions when stretched 
across the build tray. On J850 3DFashion printers, before every print job, you 
need to adjust the height of the tray to ensure the correct distance between the 
fabric and the roller when printing begins. If the tray height is not adjusted, it 
can adversely affect the pattern printed on the fabric.  

To adjust the tray height:

1. Prepare two transparency sheets (supplied in the Start-Up Kit).

2. Start the Cleaning wizard from the Options menu.
See "Cleaning the Print Heads, UV Lamp Glass, Roller and Wiper" on 
page 4-46.

Make sure that the roller is clean, so that it does not stain the textile during 
printing.

3. After completing the Cleaning wizard, place the fabric on the build tray.
See "Preparing the Build Tray for Printing on Fabric" on page 4-8.

4. From the Options menu, select Motors Control.

Figure 4-9    Options menu > Motors Control (J850 3DFashion)

5. Select the Enable check box.

Figure 4-10    Motors Control window—Z tab
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6. Make sure that the print block is in the left rear corner of the printer.

Caution:
Moving the print block manually induces an electrical current that can 
damage components. Move the print block slowly to minimize the current 
and reduce the risk of damage.

Figure 4-11    Print block in the left rear corner 

7. Close the printer cover and click Lock Door.

8. Click Home.
The build tray moves to its Home position.

9. Click Goto.
The build tray moves to the saved tray height start poistion.

10. Make sure that the Units are set to Steps.

Figure 4-12    Setting the initial tray height
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11. Click Unlock Door.

Figure 4-13    Motors Control window

12. Open the printer cover.

13. Holding the two transparency sheets together, place them in the left rear 
corner of the build tray, and move the print block over the transparency 
sheets.

Caution:
Moving the print block manually induces an electrical current that can 
damage components. Move the print block slowly to minimize the current 
and reduce the risk of damage.

Figure 4-14    Placing two transparency sheets under the print block
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14. Slide the transparency sheets back and forth under the print block.
The transparency sheets should slide in and out from under the print block 
and you should feel some friction between the roller and the transparency 
sheets.

Caution:
Too much friction between the roller and the fabric may damage the fabric. 
Make sure that the roller only slightly contacts the transparency sheets.

15. If there is some slight friction, continue with step17 If not, continue with step 
16, below.

16. If there is no friction or too much friction, continue as follows:
a. Move the print block to the left rear corner of the printer.

Caution:
Moving the print block manually induces an electrical current that can 
damage components. Move the print block slowly to minimize the current 
and reduce the risk of damage.

b. Remove the transparency sheets from the printer.
c. Close the printer cover and click Lock Door.
d. Select the Enable check box.
e. Click Home and click Goto.
f. Raise or lower the build tray by 10 steps. 

To do this, in the Move  field, type 10 to lower the tray, or -10 to raise 
the tray, and click Move. 

Note:  To raise the tray,  enter a negative value. To lower the tray,  enter 
a positive value.

Figure 4-15    Raising the tray by 10 steps (J850 3DFashion)

g. Click Unlock Door and open the printer cover.
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h. Using the transparency sheets, check if there is friction between the tray 
and the roller.   If not, repeat the above steps   until there is slight friction.

Important:
Clicking Home sends the tray back to the Home position and the current 
tray position is not saved. In the next attempts, make sure that you 
increment by 10 steps each time. For example, in your second attempt, 
raise or lower the tray by 20 steps and try again. 

17. Repeat the process  from step 14 over the entire surface of the build tray 
and make sure that there is slight firction in all areas.

Caution:
Moving the print block manually induces an electrical current that can 
damage components. Move the print block slowly to minimize the current 
and reduce the risk of damage.

18. When there is slight friction with the roller over the entire build tray surface, 
type the value from the Position field into the Goto field.

Figure 4-16    Entering the Position value in the GoTo field

19. Click Save to save the new build tray height start position.

20. Move the print block to the left rear corner of the printer.

Caution:
Moving the print block manually induces an electrical current that can 
damage components. Move the print block slowly to minimize the current 
and reduce the risk of damage.

21. Close the printer cover and click Lock Door.
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22. Select the Enable check box.

23. Click Home. 

24. Click Close.

Starting Printing

To begin printing:
➢  On the printer interface, click the red button to switch the printer to online 

mode.
The color of the button changes from red to green (see the figure on 
page 4-4).  If there is a job in the printing queue, it is sent to the printer.

When switching the printer to online mode, a message is displayed if a 
maintenance activity is required to ensure optimum printing quality. (See 
"Routine Maintenance Schedule" on page 4-39.) Maintenance notifications 
can be disabled/enabled from the Options menu.

In the printer interface, the printer mode changes from Idle to Pre-print, as the 
printer’s components prepare themselves for production: 

• The print block is heated.

• The UV lamps are powered and they warm up.
When printing begins, the print manager program sends a number of slices to 
the printer-control application. This fills the  buffer between the print manager  
and the printer to ensure continuous printing. As each slice is printed as a layer 
on the build tray, another slice is sent to the printer.

Depending on the size of the 3D print(s) to be produced, printing can take 
between several hours to several days. As long as there is enough model and 
support material in the supply cartridges, printing proceeds automatically until 
the job is finished.

J850/J835 printers use up to seven different model-material cartridges to 
produce 3D prints. In addition, a support-material cartridge is required. If 
additional cartridges are installed and they are not immediately needed for 
printing, the printer interface indicates this (see "Printer Interface Color Key" 
below).

Printer Interface Color Key

The background colors in the printer indicator fields tell you at a glance 
whether or not the value or item is suitable or ready for printing. 

• Green—suitable/ready for printing
For example, in Figure 4-4 on page 4-7:

❒  Heads (°C)—The heads have reached the temperature required for 
printing.

❒  Ambient—The ambient temperature of the printing chamber is within 
the acceptable range.

❒  Heads Liquid—The level of model and support material in the 
print-block reservoir is OK.
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❒  Heads Vacuum—The vacuum level in the system is within the 
acceptable range.

❒  Pre-Heater—The model and support resins have been heated to the 
required temperature before being supplied to the print block.

 
• Blue—not ready

For example, in Figure 4-4 on page 4-7:

❒  UV lamps—The UV lamps are not on.
 

• Red—not suitable for printing (or indicates a warning)
For example, in Figure 4-4 on page 4-7:

❒  Waste—The weight of the waste container is 9000 grams, more than 
allowed when beginning a print job. (See "Replacing the Waste 
Container" on page 4-134.)

The color of the material cartridges displayed in the printer interface indicates 
which cartridges are active for the current (or next) print job.

For example, in Figure 4-3 on page 4-4:

• Blue—active cartridge

• Gray—reserve cartridge
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Printing Indicators

The printer interface screen changes when you send a print job to the printer, if 
the printer is online:

• The mode changes from Pre-print to Printing. 
• The specific activity being performed is shown in the “current activity” field. 

• Current job-printing information is displayed.

• The printing progress bar is displayed.

• The Stop and Pause buttons are enabled.
When the weight of a cartridge drops below 100 grams, the display of the 
material level in the printer interface is red. 

Figure 4-17                Printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted, the print manager stops sending slices to 
the printer. This can happen, for example, if the printing material runs out in the 
middle of a print job, and you do not replace the empty cartridge immediately.  
After the printer changes to Standby or Idle mode, you need to resume printing 
from the print manager in GrabCAD Print.

After printing stops, the printer goes into Standby mode, when heating of 
the print heads is reduced. About 10 hours later, the printer goes into Idle 
mode, when heating of the print heads is stopped. 

To continue printing  :

1. If the printer is in offline mode, switch it to online mode by clicking the red 
button at the bottom of the  printer interface (see the figure on page 4-4).
The button changes from red to green.

2. If you don’t know why printing has stopped, make sure that the connection 
between the printer and the server computer is active.

3. Open the Schedule screen of GrabCAD Print.

Figure 4-18    Opening the Schedule screen 

4. Locate the stopped job.

Figure 4-19    Stopped job in the Schedule screen

5. Click on the job to display the Job Status details, and click the Resume  icon 

. 
OR—

Right-click on the job to display the pop-up menu, and select Resume job.
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6. In GrabCAD Print, make sure that the correct slice number is entered in the  
dialog box.

Figure 4-20    Slice confirmation in GrabCAD Print

 
Figure 4-21    Printer interface after interrupted printing

7. If, for any reason, the correct number does not appear in the dialog box, 
enter the number and click OK.

You cannot continue printing  if:

• The number of the last slice printed does not appear in the printer interface, 
even if the server computer displays the confirmation dialog box.

• There was a relatively long interruption in printing, even if the “last slice” and  
indicators are correct. This is because the part already printed might slightly 
deform or shrink before printing continues, causing a visible difference 
between it and the part printed later. The effects of a printing stoppage 
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depend on part size and structure, the model material used, ambient 
temperature and the length of the stoppage.

If you cannot continue printing: 

1. Cancel the job.
In GrabCAD Print, in the Schedule screen (see above): 

❒  Right-click on the job to display the pop-up menu, and select Cancel 
job.

OR—

❒  Left-click on the job to display the Job Status details, and click the 

Cancel  icon . 

2. Remove the partially printed 3D print from the build tray. 

3. Resend the job to the printer.

❒  Click .

You can stop  printing from either the printer interface or from GrabCAD 
Print. 

• After clicking the Stop button in GrabCAD Print, you can resume   printing 
from GrabCAD Print or from the printer interface.

• After stopping printing from the printer interface, you can resume printing 
only from the printer interface. 

• After clicking the Pause button in the printer interface, you can resume 
printing only from the printer interface.
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Changing the Printing Material

Before producing 3D prints using a different type of printing material than is 
currently installed, run the Material Replacement wizard to flush the print block 
and feed tubes.

After using the wizard to change the support material and certain model 
materials, Head Optimization is required before   printing.

You should carefully plan production of 3D prints the with different materials 
to avoid unnecessary waste of the materials currently loaded. The amount 
of material flushed depends on the flushing cycle chosen and if you are 
replacing one or more cartridges.

The Material Replacement wizard suggests the best slot locations for 
placing different material cartridges, based on the materials currently in the 
system. This ensures minimum flushing of materials currently loaded.

Note: When performing manual material replacement, certain  replacement 
options are blocked to protect the system. In these cases, follow the 
recommendations of the Material Replacement wizard for best replacement 
options.

To replace the printing material with the wizard:

1. Start the Material Replacement wizard from the Options menu.

Figure 4-22    Starting the Material Replacement wizard

2. In the opening screen, click Next.

3. If the printer cover is not closed, a screen appears, prompting you to close 
the cover. Confirm that it is closed and click Next.



Stratasys J850/J835 User Guide 4 Operating and Maintaining the Printer

DOC-18001 Rev. H 4-22

4. Choose the configuration for producing 3D prints:
❒  7 Materials (High Mix / High Quality)
❒  3 Materials (High Speed)
❒  Single Material (Super High Speed)

Figure 4-23    Material Replacement Options
7 Materials
Each print head is loaded with two different materials. 

Figure 4-24    Seven model materials loaded in the print heads
You can print with any single material, or with a combination of them. High-
speed printing is not available, but high-quality 3D prints can be produced.
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3 Materials
Both sections of each print head are loaded with  the same material.

 
Figure 4-25    Three materials loaded in the print heads
Up to three model materials are available, with high-speed printing.

Single Material
Both sections of two print heads are loaded with  the same model material.
Both sections of two print heads are loaded with Support material.

 
Figure 4-26    One model material loaded in the print heads
This mode produces parts in Super High Speed mode, at a layer resolution 
of 55 microns.

5. In the Required materials section of the wizard screen, select one or more 
replacement materials cartridges.

6. For model materials, select Both if you need to load two replacement 
cartridges.
Loading one replacement cartridge is more economical because it 
potentially requires less flushing of material currently in the system. 
However, when one cartridge is not sufficient, loading two cartridges 
enables continuous printing until the print job is completed. When one 
cartridge empties and the other one is being used, you can replace the 
empty cartridge with a new one.
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7. For Support material, select  the number of cartridges to replace.
❒  In High Mix / High Quality and High Speed modes, you can print using 

one or two Support cartridges.
❒  In Super High Speed mode, at least two Support cartridges are 

required; you can print with up to four Support cartridges.

8. If the color or mechanical properties of the first 3D prints are unimportant, 
and if you did not change the printing mode (High Quality/Speed) you can 
replace the model materials without flushing out the current materials. To 
do so, continue with  "Changing Model Materials Without Flushing" on 
page 4-26.

9. To flush out material currently in the system, choose the flushing cycle that 
fits your needs:

The default flushing cycle is the one used for the last material replacement.

❒  Economy. This cycle can be used when replacing a light-colored model 
material with a darker material (such as Agilus30 Black™ or 
VeroBlack™) or if the exact color of the 3D print is unimportant. Use this 
cycle when replacing cleaning fluid with any model material.

The wizard flushes the system with the minimum amount of material 
needed to ensure that 3D prints have the mechanical properties of the 
new material.

❒  Full. Use this cycle when the 3D print must have the exact color of the 
new material.

The wizard thoroughly flushes  the feed tubes and print heads needed 
for printing, based on your selections in the previous screens. 

There are additional settings that you can select for special purposes (see 
"Advanced Settings"). If necessary, click Advanced Settings before 
clicking Next.
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10. Click Next to begin the material replacement process in the printer.
The Cartridge Positioning screen appears, showing you the new location of 
all cartridges in the material cabinet.

Figure 4-27    Cartridge placement
Symbols:

 The correct cartridge is in this slot.

 No cartridge (or the incorrect cartridge) is in this slot.

 The cartridge in this slot has insufficient weight to complete the material 
replacement process.

 The expiration date of the cartridge in this slot has passed.

11. Replace material cartridges as necessary, according to the instructions in 
the wizard screen.

12. Click Start.

13. Read the warning message, and click OK.

If you continue, you must complete the material replacement process 
before you can produce 3D prints. To replace material cartridges at another 
time, click Cancel. If you continue (by clicking OK) and you do not complete 
the process, you will need to run the wizard again before producing 3D 
prints. 

14. In the final wizard screen, click Done.
The printer-control application is automatically updated, and it restarts. 

When it opens, the interface displays the new material(s). 

 The interface in the job preparation application  is also updated, and it 
displays the new material(s).

15. Inspect the area around the purge unit and clean it, if necessary.
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Before printing, you need to run the Head Optimization wizard in these 
cases:

• after replacing Vero with Digital ABS or Agilus30 model materials (and the 
reverse)
 • after changing the type of Support material (SUP705/706)
 • after replacing the Support material with cleaning fluid (and the reverse)
See "Optimizing (Calibrating) Print Heads" on page 4-64

Changing Model Materials Without Flushing

If you do not change the printing mode (High Quality/Speed) you can replace 
the model materials without flushing out the current materials. Use this option 
when the color or mechanical properties of the 3D print are unimportant.

To change model materials without flushing:

1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection and click 
Apply.

 
Figure 4-28    Manual slot selection
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3. When the Material Replacement Options screen opens, select the Replace 
materials without flushing check box and click Next.

Figure 4-29    Replace materials without flushing

4. In the confirmation message that appears, click Yes to continue. 

 
Figure 4-30    Replace without flushing confirmation message
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5. In the Cartridge Positioning and Process Progression screen, click Start.

 
Figure 4-31    Cartridge Positioning and Process Progression screen

6. Read the Warning message that appears, and click OK to continue.

 
Figure 4-32    Warning message
Material replacement begins.
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Advanced Settings

The Advanced Settings dialog box enables you to configure the Material 
Replacement wizard for special purposes. If necessary, click Advanced 
Settings in the Material Replacement Options screen before clicking Next.

Positioning

By default, Automatic slot selection determines the best slot locations for the 
cartridges in the material cabinet, based on materials currently in the system. 
This ensures minimum flushing of materials currently loaded.
Select Manual slot selection—             

• if there is a special need to load cartridges in certain slot locations.             

• if you only want to change one of the cartridges for a given material 
channel.

Some materials cannot replace certain other materials. If you attempt to do 
so, the wizard notifies you.

To select the slots for the cartridges manually:

1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection, and click 
Apply.

 
Figure 4-33    Manual slot selection
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3. In the Material Replacement Options screen, Both cartridges is selected 
for each position. To print with only one of the cartridges, clear the check 
box  and then select either the left (L) or the right (R) cartridge.

Figure 4-34    Manual cartridge selection

 
When printing in High Speed mode (three materials), the same material is 
used in both sections of each print head. The material selected for one of 
the cartridge slots is also used in the other print head channel.

Figure 4-35    Manual cartridge selection—3 model Materials
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4. After selecting the materials for the appropriate cartridge slots, the 
Cartridge Positioning screen appears. Place the cartridges in the materials 
cabinet as shown in this screen.

Figure 4-36    Cartridge Positioning screen (High Speed mode)

Additional Flushing Cycles

The flushing cycle you select in the Material Replacement Options screen 
determines how thoroughly to flush out material currently in the system. After 
selecting the Economy cycle and completing the wizard, you might decide that 
you require a more thorough flushing, to ensure accurate  colors. Or, you may 
notice that the 3D prints are not satisfactory because they contain traces of the 
previous material. If so, you can flush out more material, so that the next print 
job will be printed with pure material.

To perform additional flushing cycles:

➢  In the Advanced Settings screen, select Enable "flush again" options 
and click Apply.

 
Figure 4-37    Enable flush again options selected

The Material Replacement Options screen appears, where you can select the 
material(s) you need to flush again.
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Keeping the Printer in Idle Mode

Between printing jobs, the printer can be left unused for up to one week. If the 
printer will not be used for more than a week, use the Shutdown wizard to 
automatically perform the procedures that must be done before turning off the 
printer (see "Shutting Down the Printer" on page 4-35).

When the printer stops printing, the printer software automatically reduces the 
temperature of the print heads, as follows:

After printing stops Mode Change in heating of 
print heads

first 15 minutes Standby 1 no change

next 1 minute Standby 2 -----

after Standby 2 Idle heating stopped

Note:   The printer mode is indicated in the upper left of the main printer 
interface screen (see the figures on pages 4-4,  and 4-17).

If, after printing a job, you know that the printer will not be used for 16 minutes 
or more, you can immediately turn off the heating of the print heads by putting 
the printer into Idle mode.

To put the printer into Idle mode:
➢  From the File menu (in the printer interface) click Exit.

Note:   The printer remains in Idle mode until you open the printer application 
and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this 
mode—with the cover closed—for up to a week. For longer periods, shut 
down the printer by running the Shutdown wizard (see "Shutting Down the 
Printer" below). 
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Setting the Cartridge Expiration Alert

The printer application records the expiration dates for each loaded cartridge. 
You can display the Cartridge Expiration Date screen from the Options menu.

Figure 4-38    Options menu

Figure 4-39    Cartridge Expiration Date screen
By default, the  expiration indicator is set to display 60 days prior to the 
cartridge expiration date. Expiration dates that are within this  time period are 
displayed in red in the Cartridge Expiration Date screen. In addition, in the 
main screen, this is indicated near the relevant cartridge. 
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Figure 4-40    Cartridge expiration  alert indicator in main screen
If this cartridge expiration indicator appears, you can display the Cartridge 
Expiration Date screen by clicking on it.

To change the cartridge expiration alert at an earlier or later time, in the 
Cartidge Expiration Alert screen, enter the desired number of days, and click 
Save.
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Shutting Down the Printer

You only need to shut down the printer if it will not be used for 30 days or more. 
Otherwise, the printer can remain on, in Idle mode. However, if there is a need 
to turn off the printer sooner, use the Shutdown wizard to automatically perform 
the necessary processes before turning off the printer

The Shutdown process flushes printing materials from printer components. 
To avoid flushing out valuable material, make sure to print  at least once a 
week. Many printer operators use this opportunity to print customer 
samples or test parts.

Before running the wizard, empty the waste container. A full waste 
container can cause the wizard to cancel or freeze.

To properly shut down, the printer needs to perform several processes. These 
are controlled by the Shutdown wizard. Except for immediate servicing, do 
not attempt to shut down the printer by simply closing the computer 
interface (the printer-control application), and never disconnect power 
to the printer before completing this wizard.

Caution
Turning off the printer for an extended period without first running the wizard 
can cause serious damage to print heads and other expensive printer parts.

Depending on the length of time the printer will not be used, you can choose 
between a short shutdown procedure, and a more thorough procedure.

• Up to 30 days: The wizard empties the print block of model and support 
material, to prevent leaks. This takes about 10 minutes.

• More than 30 days: The wizard empties the print block, then flushes the 
system with cleaning fluid. This takes up to 75 minutes, and you must be 
present to load a cleaning-fluid cartridge when instructed. 

To run the Shutdown wizard:

1. Start the Shutdown wizard from the Options menu.

Figure 4-41    Shutdown wizard, opening screen
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2. Click Next.

3. Select the option corresponding to the length of time that the printer will not 
be used—less or more than 30 days.

Note:   Before selecting More than 30 days, make sure that cleaning-fluid 
cartridges are available.

Figure 4-42    Shutdown options
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4. In the next screen, verify that the tray is empty and click Next.             

Figure 4-43    Tray status
 

The shutdown procedure begins.

Figure 4-44    Shutdown progress

5. Follow the instructions until cleaning is completed.
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6. When the final wizard screen appears, close the printer-control application 
and shut down the printer computer.

Figure 4-45    Final Shutdown wizard screen

7. After the printer computer shuts down, turn off the main power switch at the 
back of the printer  (see Figure 4-2 on page 4-3).
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Maintaining the Printer

Performing routine maintenance tasks is essential for getting satisfactory 
results from your printer. Perform the tasks at specified intervals.

Routine Maintenance Schedule

Frequency Task For More 
Information

Before printing Clean the UV lamp lenses. "Cleaning the Print 
Heads, UV Lamp 
Glass, Roller and 
Wiper" on page 4-
46.

Before / after printing Check the UV lamp overheating indicator. See "UV Lamp 
Check         " on page 4-
42.

Before / after printing Routine cleaning of:
• print heads
• UV lamp glass lenses
• roller surface
• wiper
• build tray and surrounding area

"Cleaning the Print 
Heads, UV Lamp 
Glass, Roller and 
Wiper" on page 4-
46.

Weekly Clean the purge unit waste collector. See step 11 of 
"Cleaning the Print 
Heads, UV Lamp 
Glass, Roller and 
Wiper".

Weekly Perform the Pattern test. See "Pattern Test" 
on page 4-42.

Weekly Back up the printer's configuration files. See "Backing up the 
Printer 
Configuration" on 
page 4-45

Weekly Restart the printer computer.  
Weekly Clean the roller waste collector. See "Cleaning the 

Roller Waste 
Collector and 
Inspecting the 
Roller Scraper" on 
page 4-51.

Every 300 hours of printing (A 
reminder message appears.)

Calibrate the UV intensity. See "Testing and 
Calibrating the 
UV Lamps" on 
page 4-82.

Every 300 hours of printing (A 
reminder message appears.)

Optimize the print heads. See "Optimizing 
(Calibrating) Print 
Heads" on page 4-
64.
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Frequency Task For More 
Information

Monthly, and after replacing 
print heads

Check the alignment of the print heads. See "Aligning the 
Print Heads" on 
page 4-57.

Monthly Remove and clean the print-head splash shield. See "Cleaning the 
Print-Head Splash 
Shield" on page 4-
62.

Monthly Clean debris from the Z-axis shaft with a vacuum 
cleaner.

 

Monthly Inspect the exhaust system (duct, fan, 
connections).

 

Monthly Calibrate the load cells. See "Calibrating 
the Load Cells" on 
page 4-90.

Every 250 hours of printing in 
High Speed or Super High 
Speed mode
(A reminder message appears.)

Flush the print-block heater. See "Flushing the 
Print-block Heater" 
on page 4-91.

Every 1000 hours of printing Replace the waste-pump tubes. See "Replacing the 
Waste-Pump 
Tubes" on page 4-
96.

About once a year (as 
necessary)

Replace the  Material Filters. See "Replacing the 
Material Filters" on 
page 4-101.

Every two years or every 3500 
hours of printing 

Preventive maintenance visit by service engineer. Contact your 
Stratasys service 
provider.

 

Maintenance Counters

The printer computer application records the dates and frequency for each 
maintenance task. You can display the Maintenance Counters screen from the 
Options menu.

Figure 4-46    Selecting Maintenance Counters
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If there is a maintenance task due, this is indicated on the main interface 
screen.

 
Figure 4-47    Maintenance Required indicator
If this indicator appears, you can display the Maintenance Counters screen by 
clicking on it.

 

Figure 4-48    Maintenance Counters screen

The Maintenance Required indicator appears by default for most operator-
performed maintenance tasks. The check box under “User Warning” 
controls whether or not it appears when a particular task is due.

For maintenance tasks that are controlled by wizards, the dates and printing 
times are reset automatically when the relevant wizard is run and completed 
successfully. Manual maintenance tasks (for example, roller inspection and 
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wiper replacement) are reset by clicking the reset button in the Maintenance 
Counters screen.

UV Lamp Check         

A heat-sensitive label is fixed to the UV lamp covers as a warning against 
overheating. Its center changes from white to black if the temperature of the 
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call your 
service provider. As a precaution, it is recommended that you check the label 
before and after printing. 

Figure 4-49    Heat-sensitive label on UV lamp cover

If the UV lamp continues to overheat, and the temperature around the lamp 
reaches 90°C (194°F), a heat fuse turns off the electricity to the power to the 
UV lamp and the motors for the X, Y, and Z axes. In the unlikely event that 
this occurs, the printer cannot be used until it is serviced by an authorized 
service engineer.

Pattern Test

The pattern test is the basic verification of the printer’s ability to produce quality 
3D prints, since it demonstrates the condition of the nozzles in the print heads. 
Make sure, therefore, that you perform this test weekly, and whenever you 
suspect a printing problem.

To perform the pattern test:

1. Make sure that the build tray is empty.

2. Prepare a sheet of pink paper, A-4 or Letter size.

3. In the printer, tape the pink paper to the surface left of the build tray.

4. Press F3, or open the Options menu and select Pattern Test.
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Figure 4-50    Selecting Pattern Test

5. Click Yes in the Confirm dialog box to begin.

Figure 4-51    Pattern Test confirmation

6. If the build tray is not clear, click No in the following dialog box.

Figure 4-52    Build tray (Z) level adjustment
The build tray is lowered to prevent damage to parts on the tray.
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The printer prints a series of lines on the test paper (see next figure).

Figure 4-53    Sample Pattern Test

7. Carefully inspect the test paper to see if there are missing lines. 
Too many missing lines, especially if they are in the same area, indicates 
that the quality of printing when producing 3D prints will be poor. If this is 
the case, see "Improving Print Quality" on page 4-46.

Note:   Acceptable 3D print quality is subjective, and depends on the type 
and scale (size) of the 3D prints produced. As a rule, however, more than 
10 missing lines in one area of a column is considered unacceptable.

If you do not see many missing lines, but you suspect that there are faulty 
nozzles in a print head, you can print samples to inspect. See "Dynamic 
Nozzle Test" on page 4-126.
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Backing up the Printer Configuration

It is recommended that you periodically back up the printer's configuration files. 
In case of printer malfunction or the need to re-install the software on the 
printer computer, parameters can be restored from the backup. The backup 
also saves the printer's log and the calibration and maintenance history.

To back up the printer configuration files:

1. From the Options menu, select Collect Service Data.
or—

Press F2.

Figure 4-54    Selecting Collect Service Data from the Options menu

2. In the confirmation dialog box, click Yes.
A zip file is saved in this folder—
\STRATASYS_J8_SERIES\ServiceData

3. Copy this file to a location that is not on the printer computer (for example, a 
network folder or a USB drive).
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Improving Print Quality

If you suspect that print quality is poor, perform the Pattern Test (see "Pattern 
Test" on page 4-42). If the results are poor, use the following procedure to 
improve print quality.

If the results of the last pattern test are poor:

1. From the Options menu, select Purge Sequence, or press F4.

2. In the confirmation dialog box, click Yes.
The print heads are purged of model and support material, and the wiper 
removes excess material from them.

3. Repeat the purge sequence.

4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see "Cleaning the Print Heads, UV Lamp 
Glass, Roller and Wiper" below).

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue left 
on them.

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:
➢  Optimize the print heads and replace faulty print heads, if necessary (see 

"Optimizing (Calibrating) Print Heads" on page 4-64).
 

Cleaning the Print Heads, UV Lamp Glass, Roller and Wiper

Regular inspection and cleaning of the orifice plates on the bottom of the print 
heads prevents print nozzles from clogging. Cleaning the roller, wiper, and UV 
lamp glass are also important for maintaining quality printing. A wizard adjusts 
printer components to enable access to these key areas, and it guides you 
through the cleaning procedure. To maintain the printer in optimum condition, 
run the wizard after every print job, when you remove the 3D print from the 
build tray. This procedure takes about 20 minutes.

Before running the wizard, empty the waste container. A full waste 
container can cause the wizard to cancel or freeze.
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To clean the printer components:

1. Prepare—
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  disposable cleaning gloves 
❒  a supplied 3M sanding sponge
❒  a supplied cleaning cloth or equivalent 
❒  a mirror

2. Start the Cleaning wizard from the Options menu.

Figure 4-55    Options > Wizards menu

3. Make sure that the build tray is clear (empty), and close the cover. Confirm 
this in the wizard screen and click Next.

Figure 4-56    Preparation check
The printer moves components to the cleaning position.
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4. When the following screen appears, open the printer.

Figure 4-57    Wizard screen during cleaning tasks

Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch 
them with your bare hands, and proceed with caution.

5. Place the mirror on the build tray. 

6. Put on the gloves.

Caution
Uncured printing material on the print heads might cause skin irritation. Use 
disposable cleaning gloves to protect your hands.

7. Soak the cleaning cloth with alcohol.
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8. Clean the orifice plates, with a back-and-forth motion. Use the mirror to 
make sure that you have removed all of the residue material.

Figure 4-58    Cleaning the heads

Once a month, remove and clean the print-head splash shield. (See step 4 
on page 4-63.)

9. Using the supplied cleaning sponge, clean the glass lens on both UV lamps 
. 

10. Using the alcohol-soaked cleaning cloth, remove any material remaining on 
the wiper and the surrounding area. 

11. Remove any pieces of waste material collected in the purge unit. If 
necessary, remove the waste collector to clean it. Wipe the rubber seal.

 
Figure 4-59    Removing the purge unit waste collector
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Note:  When returning the waste collector to the purge unit, make sure to insert 
it as shown.

12. Inspect the wiper.
If the wiper is scratched, torn or worn, or if you cannot clean it completely, 
replace it.

a. Grasp it and pull it up and out of its bracket. 
b. Insert the new wiper blade, making sure that it is straight and secured 

well on both sides. 

13. Select the confirmation check boxes in the wizard screen (see Figure 4-57) 
and click Next.

14. Activate the roller, so that it rotates while you clean it.

Figure 4-60    Roller-rotation activation

15. With a cleaning cloth soaked with alcohol, clean the roller surface, as it is 
rotating.

Caution
Use caution when cleaning the rotating roller. Use a cleaning cloth or the 
supplied UV sanding sponge.
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16. When the roller is clean, select the confirmation check box in the wizard 
screen and click Next.

Figure 4-61    Clean-roller confirmation
The roller stops rotating when you click Next.

17. Remove the cleaning materials from the printer and close the printer cover.

18. Select the confirmation check boxes in the wizard screen and click Next.
The head-purge cycle begins. When this is complete, the final wizard 
screen appears.

Figure 4-62    Cleaning wizard—final screen

19. Click Done to close the wizard.

Cleaning the Roller Waste Collector and Inspecting the Roller Scraper

The roller waste collector removes waste material scraped from the roller. 
Suction removes this waste to the printer’s waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes 
leading to the waste container, so that waste material does not overflow into 
the printer.
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To clean the roller waste collector:

1. Prepare—
❒  M2.5 and M2 Hex (Allen) keys
❒  disposable cleaning gloves
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  cleaning cloth
❒  cotton swabs (Q-tips or similar)
❒  mirror
❒  flashlight

2. From the Option menu, select Go to Head Inspection Position.

3. Put on the gloves.

4. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Figure 4-63    Disconnecting the right UV assembly

b. Remove the screw that secures the right UV lamp, and then pull and lift 
up the UV lamp.
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5. Loosen the two screws securing the suction tube on the print block.

Figure 4-64    Lifting the suction tube

6. Lift the suction tube to secure it in a raised position.

7. Remove the two screws securing the covering of the roller waste collector 
and remove it.

Be very careful to save the covering screws. These are special screws; if 
they are lost, you need to order replacements.

Figure 4-65    Removing the roller waste collector screws

8. Remove the covering by pulling it out, and then lower it.
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9. Clean the roller waste collector and the scraper blade surface using cotton 
swabs. Make sure to remove any remaining printing materials.

Figure 4-66    Cleaning the roller waste collector

Before replacing the covering, you can check the effectiveness of the roller 
scraper—see below.

To check the effectiveness of the roller scraper:

1. Put on the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.

4. Turn the roller slowly with your hand. As the blade scrapes the roller, make 
sure the isopropanol is spread evenly over the entire length of the blade.

5. Inspect the roller. If it is not dry, replace the blade. (See "Replacing the 
Roller Scraper" on the next page.)

6. Before returning the roller waste collector to the print block, make sure that 
the pins are clean. 

Figure 4-67    Roller waste collector pins

To re-assemble the components:

1. Return the roller waste collector to the print block and screw on the 
covering (see Figure 4-65 on the previous page).
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2. Loosen the screws securing the suction tube.

Figure 4-68    Positioning the suction tube

3. Lower the suction tube so that the hole in the panel behind the tube is 
visible, and tighten the screws to secure the tube. 

4. Attach the right-UV-lamp assembly to the print block and reconnect the UV 
power and fan cables.

Replacing the Roller Scraper

You should replace the roller scraper blade—
• after 1,000 hours of printing.
• if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you 
clean the roller waste collector. See "Cleaning the Roller Waste Collector 
and Inspecting the Roller Scraper" on page 4-51.

To replace the roller scraper:

1. Prepare—
❒  a new roller scraper blade
❒  a Phillips 1x75 mm screwdriver
❒  a 2.5-mm and a 2-mm hex (Allen) key

2. Remove the right UV lamp and the roller waste collector covering (see 
steps 4 to 7  on page 4-52).

3. Loosen the two screws securing the roller waste collector and pull it out.

Figure 4-69    Removing the roller waste collector
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4. Remove the screws that secure the roller scraper assembly. 

Figure 4-70    Removing the roller scraper screws

5. Remove the scraper blade and discard it.

Figure 4-71    Removing the old roller scraper blade

6. Place the new scraper blade onto the pins in the holder, as shown. 

Figure 4-72    Inserting the new roller scraper blade
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7. Insert and tighten the roller scraper blade screws.

Important:
 l Tighten the screws in the order shown in Figure 4-73.
 l Use the new screws supplied in the replacement kit

Figure 4-73    Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is 
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the print 
block. (See steps 5 to 7 on page 4-52 in "Cleaning the Roller Waste 
Collector and Inspecting the Roller Scraper".)

Aligning the Print Heads
You should check the alignment of the print heads— 

• once a month
• after replacing one or more heads
• if  quality is not acceptable even after cleaning the orifice plate on the bottom 

of the print block (see "Cleaning the Print Heads, UV Lamp Glass, Roller 
and Wiper" on page 4-46).

This procedure takes about 20 minutes.

To check the alignment of the print heads:

1. Prepare—
❒  a transparency sheet, A-4 or Letter size
❒  any type of adhesive tape, to fasten the transparency sheet to the build 

tray

2. Start the Head Alignment wizard from the Options menu.
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3. When the following screen appears, place the transparency on the build 
tray—next to the left and rear edges of the tray (see below).

Figure 4-74    Transparency confirmation

Figure 4-75    Positioning the transparency on the build tray

4. Make sure that the transparency sheet is lying flat, and tape it to the tray.

5. Close the printer cover.

6. In the wizard screen, select the check box to confirm that the transparency 
sheet is secured to the build tray, and click Next.

7. If the printer is currently loaded with seven model materials (High Mix / 
High Quality mode), select the mode for aligning the print heads.

Figure 4-76    Mode selection
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When you click Next, the printer prints the head alignment test on the 
transparency. When printing is finished, the following screen appears.

Figure 4-77    Head Alignment wizard—steps 8–10

8. Open the printer and remove the transparency.
The transparency sheet is printed with sets of vertical lines in seven 
columns, each showing the results from a different print head.

Figure 4-78    Sample head-alignment test

Note:   There is no column for head H7 because its alignment is used as a 
reference for aligning all other heads.

9. For each column of lines, use a magnifying glass or loupe to inspect pairs of 
consecutive rows printed on the transparency to see where the vertical 
lines align.

Figure 4-79    Comparing rows of alignment lines

Note:   It does not matter which pair of lines you inspect, since they were all 
printed by the same head. Choose a pair of clearly printed lines for the 
inspection. (Since some nozzles may not print clearly, you may have to 
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper and 
lower rows are aligned, as in Figure 4-79. In the example shown, no change 
to the head alignment is necessary. If other lines in the set are aligned, you 
need to change the alignment of that head—in the next wizard screens.
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10. In the wizard screen shown in Figure 4-77, select the Transparency 
removed check box, and click Next.
The first in a series of alignment screens appears.

Figure 4-80    Head alignment selection

11. In the head-alignment screen, select the number that indicates which lines 
align in the upper and lower rows of a pair on the transparency (counting 
from the left) for this print head.

Note:   Because the alignment of the fourth lines is optimum, the number 
“4” is selected, by default, in the wizard screen. This does not change the 
head alignment. If you select other numbers, the wizard adjusts the head 
alignment, accordingly.

12. Click Next to display the next head alignment screen, and again select the 
number representing the most closely aligned vertical lines on the 
transparency for that print head.
When you have finished aligning all of the heads, the following screen is 
displayed.

Figure 4-81    Parameter update confirmation
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13. Continue as follows:
❒  To make the alignment changes in the printer, make sure that Update 

system with new parameters is selected, and click Next. 
A message  that the parameters were updated appears. For all modes, 
except High Quality, since the update to parameters can affect the color 
uniformity, it is recommended to continue directly with the Color 
Uniformity wizard.

❒  To recheck the alignment test results before making the alignment 
changes in the printer, click Previous.

❒  If you do not want to make alignment changes in the printer at this time, 
select Keep previous parameters, and click Next.

14. In the following screen, you can choose to either repeat the head alignment 
procedure, continue to the Color Uniformity wizard, or close the wizard. 

 
Figure 4-82    Repeat head alignment option

❒  If the most closely aligned vertical lines for a print head were at either 
extreme, choose Repeat the test, then click Next. 
The additional transparency test will show if the heads are now properly 
aligned, and—if not—the wizard will allow you to “fine tune” the 
alignment.

❒  For High Mix and High Speed modes, if the head alignment parameters 
were updated, you should "fine tune" the print heads to ensure color 
uniformity, especially along the part's X-walls. To do this, choose Run 
Color Uniformity Wizard and click Next. The Head Alignment Wizard  
Completed screen appears. When you click Done , the Color Uniformity 
wizard opens.

❒  If the vertical lines for the print heads were not aligned at either extreme, 
or if you do not want to run the color uniformity wizard, choose End this 
wizard, then click Next.
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Cleaning the Print-Head Splash Shield

To prevent excess printing material from accumulating around the print heads, 
a splash shield is installed on the bottom of the print block. Remove the shield 
and clean it once a month, when cleaning the print heads (see "Cleaning the 
Print Heads, UV Lamp Glass, Roller and Wiper" on page 4-46).

To remove the print-head splash shield:

1. Run the Cleaning wizard from the Options menu.
When the printer moves components to the cleaning position, the following 
screen appears.

Figure 4-83    Wizard screen during cleaning tasks

2. Open the printer and place a mirror on the build tray.

3. Put on cleaning gloves.

Caution
Uncured printing material on the print heads might cause skin irritation. Use 
disposable cleaning gloves to protect your hands.
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4. Using a 2-mm hex (Allen) key, remove the screws to remove the splash 
shield.

Figure 4-84    Print-head splash shield installed on the print block

Figure 4-85    Removing the print-head splash shield

Warning: Hot Surface
The print head orifice plates (bottom surface) may be hot. Do not touch 
them with your bare hands, and proceed with caution.

5. Soak a cleaning cloth with 90% alcohol and clean the splash shield.

6. Return the splash shield to the print block and secure it with four (4) screws.

After cleaning the print heads and the splash shield, continue with step 9 
in the daily cleaning routine (see "Cleaning the Print Heads, UV Lamp 
Glass, Roller and Wiper" on page 4-49).
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Optimizing (Calibrating) Print Heads

The condition of the print heads directly affects the quality of 3D prints. To 
maintain optimum printing, you should routinely test the print heads, and 
calibrate them to the best working configuration possible by running the Head 
Optimization wizard every 300 hours of printing.

You also need to calibrate the print heads in these cases:
• after changing the printing mode between High Mix / High Quality and one 

of the high-speed modes

• after replacing Vero with Digital ABS or Agilus30 model materials (and the 
reverse)

• after changing the type of support material (SUP705/706)

• after replacing the support material with cleaning fluid (and the reverse)
During this procedure, you place a scale on the build tray and connect it to the 
printer. Printing material (resin) is jetted from each head and its weight is 
automatically recorded and the wizard determines how to optimize the print 
heads. 

If, during the optimization process, the wizard determines that a print head is 
faulty—or that it is negatively affecting layer uniformity with the current head 
configuration—the wizard instructs you to replace it. If this happens, you can 
continue the wizard to replace the print head, or abort the wizard, to replace the 
head at another time. 

Run the Head Optimization wizard every 300 hours of printing or whenever 
the condition of print heads is negatively affecting the quality of 3D prints, or 
if you suspect that there is a problem with one or more of the print heads.

Before running the wizard, empty the waste container. A full waste 
container can cause the wizard to cancel or freeze.

Note: To accurately test and calibrate print heads, they must be clean. If 
necessary, run the Cleaning wizard before beginning this procedure.

To test and calibrate the print heads:

1. Prepare—
❒  disposable cleaning gloves (any clean, powder-free protective gloves)
❒  pink paper
❒  the Missing Nozzles ruler
❒  the scale supplied for use in the Head Optimization wizard
Important:  Before beginning this procedure, ensure that the scale is 
calibrated and at least partially charged. 
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2. Start the Head Optimization wizard from the Options menu.

Figure 4-86    Starting the Head Optimization wizard

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.

5. In the following screen, select Continue with Head optimization if you 
have recently cleaned the print heads. Otherwise, cancel the wizard and 
run the Cleaning wizard.

Figure 4-87    Clean print heads screen
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6. In the following screen, make sure Optimize all print heads is selected, and 
click Next.

Figure 4-88    Procedure selection screen

7. Select the printing mode for which you want to optimize the print heads and 
click Next.

Figure 4-89    Printing mode selection

Note: The mode options depend on the materials loaded in the printer.
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8. Make sure that the build tray is clear and clean, and confirm this in the 
wizard screen. 

Figure 4-90    Preparing for head optimization (1)
When you click Next, a frame is printed on the build tray.

9. When the following screen appears, open the printer and tape a sheet of 
pink paper to the surface left of the build tray.

Figure 4-91    Preparing for head optimization (2)
When you click Next, the Pattern Test is printed on the pink paper.
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10. When the following screen appears, open the printer and remove the 
Pattern Test paper.

Figure 4-92    Enter Missing Nozzles screen

11. Carefully inspect the Pattern Test paper with the Missing Nozzles Ruler to 
see if there are missing lines.

Figure 4-93    Inspecting the Pattern Test
Each missing line represents a faulty nozzle in the print head.

12. In the Missing Nozzles screen, enter the number of missing nozzles for 
each print head and click Next.
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13. The wizard continues according to the number of missing nozzles you 
entered. 
❒  If there are too many missing nozzles for acceptable printing, the wizard 

instructs you to replace the defective print head(s). You can do this now, 
or abort the wizard.

If you are prepared to replace print heads now, the wizard guides you 
through the procedure when you click Next. Make sure you have 
replacement heads and the required tools (see page 4-73). Then, 
continue with "Preparing the Print Block" on page 4-74.

Figure 4-94    Head replacement due to missing nozzles
❒  If the number of missing nozzles in all print heads is acceptable, the 

wizard continues with the head optimization process (below).

14. Set up the scale in the printer by performing the steps listed in the wizard 
screen.

Figure 4-95    Setting up the Head Optimization scale



Stratasys J850/J835 User Guide 4 Operating and Maintaining the Printer

DOC-18001 Rev. H 4-70

15. After confirming all of the items listed in the wizard screen, click Next.
Printing material (resin) is jetted from each head and its weight is 
automatically recorded. Then, the following screen appears.

Figure 4-96    Emptying the resin container

16. Open the printer. Carefully remove the resin container from the scale and 
empty it into the purge unit. Then return the container to the scale.

Caution: The resin in the container is uncured
 l To prevent contact with skin, wear neoprene or nitrile gloves.
 l Dispose of uncured resin in accordance with applicable regulations. By 

emptying the container into the purge unit, the resin is stored in the printer’s 
sealed waste container.

17. Close the printer cover, confirm the items listed in the wizard screen, and 
click Next.
The printer cures the resin in the container.

18. When the following screen appears, open the printer and remove the scale. 

Figure 4-97    Remove Scale confirmation screen

19. Confirm the items listed in the wizard screen, and click Next.
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The wizard uses the data collected to analyze the condition of the print 
heads and optimize them so they print  with a uniform layer of material. 

❒  If the heads are in satisfactory condition, the following wizard screen 
appears.

Figure 4-98    Final wizard screen, after optimizing print heads
❒  If the wizard determines that a print head is faulty—or that it is 

negatively affecting part quality with the current head configuration—
you need to replace it. Indicate whether or not you want to do so now.

Figure 4-99    Defective print heads found

• Select Replace defective head(s) if you are prepared to replace 
the print heads now (see below). 

or—

• Select Abort wizard if you want to replace the print heads at 
another time.

Replace print heads only after consulting with an authorized Stratasys 
service provider.
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To replace print heads, you need these tools and materials:

❒  replacement print head(s)
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  disposable cleaning gloves (supplied with the print head; or use any 

clean, powder-free protective gloves)
❒  a supplied cleaning cloth or equivalent
❒  a mirror
❒  a 4-mm hex (Allen) key
❒  a small Phillips screwdriver
❒  the Missing Nozzles ruler
❒  the scale supplied for use in the Head Optimization wizard (Weight 

Test)
Important:  Before beginning this procedure, ensure that the scale is 
calibrated and at least partially charged. 

If you are replacing print heads now, the wizard guides you through the 
procedure when you click Next. Continue with "Replacing Print Heads" below.

Replacing Print Heads

The condition of the print heads directly affects the quality of 3D prints. You 
may need to replace a print head if one or more of the following symptoms 
occurs:

• The Head Optimization wizard determines that a print head is defective. 
(See "Optimizing (Calibrating) Print Heads" on page 4-64.)

• There are noticeable grooves in the surface of 3D prints.

• Visual inspection of the head reveals that its surface is damaged—peeling 
or bubbles in the nozzle area.

• The printer interface displays a warning or malfunction message relating to 
a print head—
❒  Head Heater temperature timeout
❒  Head Heater thermistor open
❒  Head Heater thermistor short

Replace print heads only after consulting with an authorized Stratasys 
service provider.

The Head Optimization wizard guides you through the procedure of replacing a 
print head, and configures printer components to enable you to perform it. Only 
replace a print head with the aid of the wizard.
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The entire print-head replacement procedure takes about 45 minutes, and 
consists of the following phases: 

A. Identifying the head(s) needing replacement. 
This is normally done by the Head Optimization wizard. Otherwise, 
evidence of physical damage to the head surface or a malfunction message 
indicates which head needs replacing.

B. Preparing the print block for head replacement.
This is done automatically when you run the wizard.

C. Removing the defective print head. 
D. Installing a new print head.
E. Optimizing the print heads (done automatically by the wizard).
F. Performing head alignment.        

 

To replace a print head:

1. Prepare—
❒  replacement print head(s)
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  disposable cleaning gloves (use clean, powder-free gloves)
❒  lint-free cleaning cloths
❒  a mirror
❒  a 4-mm hex (Allen) key
❒  the scale supplied for use in the Head Optimization wizard (Weight 

Test)
❒  the Missing Nozzles ruler

Important:  Make sure that you have these items and that the scale is 
calibrated and at least partially charged before continuing.

2. Start the Head Optimization wizard from the Options menu (see the figure 
on page 4-64).

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.

../../../../../Content/6_Topics_Printer/printer_aligning_print_heads.htm
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5. In the following screen, select Continue with Head optimization if you 
have recently cleaned the print heads. Otherwise, cancel the wizard and 
run the Cleaning wizard.

Figure 4-100    Clean print heads screen

6. In the following screen, select Replace faulty heads, and click Next.

Figure 4-101    Procedure selection screen

Preparing the Print Block

7. Select the print head(s) needing replacement, and click Next.

Figure 4-102    Head selection screen



Stratasys J850/J835 User Guide 4 Operating and Maintaining the Printer

DOC-18001 Rev. H 4-75

The printer heats and empties the print block, and prepares the printer. 
(This should take up to 15 minutes.)

The following screen appears when the printer is ready for you to replace 
print heads.

Figure 4-103    Printer ready for head replacement

8. Put on the protective gloves and open the printer cover.
Note: The printer disconnects power to the heads for your safety.

Removing the Defective Head

9. On the front of the print block, loosen the screws that secure the cover 
protecting the print-head driver cards. 

Figure 4-104    Loosening the driver-card cover screws

10. Lift up the cover.
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11. Loosen the screws that secure the driver-card bracket, and lower the 
bracket.

Figure 4-105    Loosening the driver-card bracket screws

12. Release the driver-card support.

Figure 4-106    Releasing the driver-card support
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13. Remove the driver card by releasing the latch at the points shown.

Figure 4-107    Releasing the driver-card latch

14. Release the upper and lower screws that secure the print head in the block. 
(If necessary, you may use a 4-mm hex (Allen) key to loosen the screws.)

Figure 4-108    Releasing the print-head locking screws
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15. Press down on the upper and lower locking screws to release the print 
head, and remove it from the bottom of the print block.

Figure 4-109    Releasing the print head

16. Make sure that along with the head, you remove the four (4) rubber O-ring 
seals.

Figure 4-110    O-ring seals on the print head
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Important
If the seals are not removed with the head, they are probably stuck to the 
print block housing. If so, remove them.

Figure 4-111    Making sure the O-rings are not stuck to the print block

Installing the New Head

17. Place four (4) O-ring seals in the replacement head (see Figure 4-110 on 
the previous page).

18. Position the head in the print block, making sure that the location pins are in 
place. 

Note: Make sure to insert the head with the contacts on the driver card 
facing the print block.

19. Tighten the upper and lower screws that secure the print head in the print 
block (see Figure 4-109 on the previous page).

Note: Hand-tighten these screws. To avoid over-tightening, do not use a 
hex (Allen) key.

20. Insert the driver card into its socket, and secure the card.

Figure 4-112    Securing the driver card

21. Lower the protective cover and tighten the screws to secure it.
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22. In the Replace print heads screen, select the check box to confirm that you 
have replaced the head(s), and click Next.

Figure 4-113    Head replacement confirmation

23. With your fingers, make sure that the new head is level and even with the 
other heads.

Figure 4-114    Checking the level of the new head

24. Confirm that the heads are level by selecting the check box in the following 
wizard screen, and click Next.

Figure 4-115    Installation-check screen
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25. In the next wizard screen, confirm that you have removed all tools and 
objects from the printer.

Figure 4-116    Cleared-tray confirmation screen

26. Close the printer cover.
The wizard continues by heating the heads, then filling and purging them.    

If installation problems are detected, the wizard alerts you and instructs you 
how to continue (see "Installation Problems" below).

27. After replacing print heads, you should run the wizard again, to optimize the 
new heads, and to make sure that they are optimized for printing with the 
other heads. In the final wizard screen, select Optimize all print heads 
and click Next.

Figure 4-117    Final wizard Screen

Installation Problems

If the printer detects that there is a problem after you install print heads, a 
relevant warning screen appears.

➢  If the printer software does not detect the replaced head, release the print 
head card and re-insert it. (see "Removing the Defective Head" on page 4-
75). 
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➢  If the replacement head was not calibrated by Stratasys, remove the head 
and replace it with another one. 

Figure 4-118    Invalid-head warning
Contact your Stratasys service provider about the uncalibrated head.

Testing and Calibrating the UV Lamps

The level of UV radiation from the lamps used for curing 3D prints can change 
over time. To ensure optimum curing of 3D prints during printing, a pop-up 
message reminds you to test the lamps and calibrate the level of UV radiation 
after every 300 hours of printing. You do this by running the UV Calibration 
Wizard.

To measure the UV radiation, you need:

• Stratasys TOL-03005-S (UV sensor and cable)
or—

• a stand-alone UV radiation meter, approved for use with the printer
The wizard compares the measured radiation to the recommended radiation 
level for each of the lamps, at each printing mode—High Speed / High Quality. 

When calibrating the lamps, the wizard attempts to adjust the radiation level, if 
necessary.

• If the reading is within the acceptable range, the wizard continues to the 
next phase. 

• If further adjustment is necessary, the current phase is repeated. 

• If the level of UV radiation is too low to be properly adjusted, the wizard 
continues to the next phase, but the final wizard screen indicates that the 
lamp’s radiation for the printing mode is unacceptable.

Before testing and calibrating the UV lamps: 
 l Make sure the glass lens on each of the UV lamps is clean. For easy 

access, run the Head Cleaning Wizard, and use the special sanding 
sponge supplied in the Start-Up Kit.

 l Make sure that the glass over the UV radiation sensor is clean.
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To test and calibrate UV lamp radiation:

1. Start the UV Calibration Wizard from the Options menu.

2. In the following screen, select Calibrate UV Intensity to adjust the lamp’s 
radiation level to the acceptable range.

Figure 4-119    UV Test/Calibration selection

3. In the following screen, select the UV sensor and measuring device to be 
used.

Figure 4-120    UV device selection

UV Measuring Device 
When you use the Stratasys UV sensor box (TOL-03005-S), you connect it 
to the printer. The wizard automatically measures and calibrates the UV 
radiation.

If you use a stand-alone UV radiation meter, you need to manually enter the 
readings from the meter in the wizard screens.
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4. Make sure that the build tray is empty. Confirm this in the wizard screen and 
click Next.

Figure 4-121    Printer preparation

➢  When using a Stratasys UV sensor box that you connect to the printer 
(TOL-03005-S), continue with "UV Sensor Connected to Printer" on the 
next page.

➢  When using a stand-alone UV radiation meter, continue with "External UV 
Meter" on page 4-87.
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UV Sensor Connected to Printer

The following steps apply when using the Stratasys UV sensor box that you 
connect to the printer. They do not apply when using a  UV external radiation 
measuring device.

1. To synchronize the wizard and the UV sensor, enter the CF number from 
the label on the back of the UV sensor box.

Figure 4-122    UV sensor synchronization

Figure 4-123    Label on the bottom of the UV sensor box
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2. Click Next.
The build tray lowers so you can connect the UV sensor box.

Figure 4-124    UV sensor connector 

3. Confirm the items listed in the wizard screen and click Next.

Figure 4-125    Sensor positioning
Continue with "UV Measurement        " on page 4-88.
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External UV Meter

The following steps apply when using a stand-alone UV meter. This section 
does not apply when using the Stratasys UV sensor box connected to the 
printer.

1. When the following screen appears, open the printer and place the UV 
sensor (probe) at the rear edge of the tray, in the center.

Figure 4-126    Sensor placement screen

2. Lead the cable out of the printer so that you can close the printer, and tape 
it down to make sure that it does not interfere with the moving print block.

 
Figure 4-127    Correct UV-sensor placement

3. Close the printer, while checking that the sensor does not move out of 
position.

4. Set the UV meter to measure mJ/cm2.

5. Set the range on the meter to 2,000.

6. Connect the cable from the sensor to the UV meter. 

7. Turn on the UV meter, and wait until “0 0 0.0” appears on the display.

8. In the wizard screen, confirm that the sensor is positioned correctly, and 
click Next.

Continue with "UV Measurement        " on the next page.         
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UV Measurement        

The UV lamps power up and stabilize. (This takes several minutes.) Then, the 
print block passes over the sensor and the wizard compares the measured 
radiation to the recommended level for each UV lamp and printing mode. 
During this process, which takes 20–40 minutes, you need to monitor the 
progress as displayed in the wizard screen.

Figure 4-128    UV measurement progress
When using a stand-alone radiation meter (not the Stratasys UV sensor box 
connected to the printer): Reset the meter and enter the reading 
(measurement) when you are prompted to do so.

 
Figure 4-129    UV Measurement dialog box
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If the UV level measured is not acceptable, the wizard calibrates the UV lamp 
by adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the 
condition of the lamps after calibration (see Figure 4-130 below).

Figure 4-130    Results and condition of UV lamps after calibration

After examining the UV calibration results:

1. Click Next.

2. Remove the UV sensor and close the printer cover. After confirming the 
items listed in the wizard screen, click Next.

Figure 4-131    UV sensor removal
If the results are not acceptable for quality printing, this is indicated in the 
final wizard screen.
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Figure 4-132    Final UV Calibration Wizard screen
Calibrating the Load Cells

Load cells are sensors that measure the weight of the material cartridges and 
the waste container in the printer. It is important that you periodically check that 
the weight measurements are accurate to prevent unnecessary waste of 
printing materials or printer malfunctions.

To calibrate load cells:

1. Start the Load Cell Calibration wizard from the Options menu.

2. In the following screen, select one or more load cells that you want to 
calibrate. 

Figure 4-133    Load cell selection

3. Remove each selected cartridge from the materials cart, and click Next.

4. In the next wizard screen, observe the numbers and wait until the weight 
level is relatively stable—two units above or below the average level 
shown.
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Figure 4-134    Weight stabilization

5. Select the check box, and click Next.

6. Click Done in the final wizard screen.

Flushing the Print-block Heater

If the printer is configured to print in High Speed mode (with three model 
materials),  or in Super High Speed mode (with one model material), the print-
block heater needs to be periodically flushed. This is necessary to prevent 
possible clogging of unused material channels in these modes. A reminder 
message appears if 250 printing hours have passed since the print-block 
heater was last flushed.

The time required for completing this procedure depends on the materials 
loaded in the printer. A time estimation appears in the wizard before starting 
the flushing process.
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To flush the Print-block Heater:

1. From the Options menu, open the Material Replacement wizard.

Figure 4-135    Opening the Material Replacement wizard

2. In the opening screen, click Next.

3. In the Material Replacement Options screen, click Advanced Settings.

Figure 4-136    Material Replacement Options screen

4. In the Advanced Settings screen, select Manual slot selection and click 
Apply.
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Figure 4-137    Manual slot selection

5. When the Material Replacement Options screen opens again, select the 
following:
❒  7 materials
❒  Economy

Figure 4-138    Selections in the Material Replacement Options screen

Make sure that the printer is loaded with the selected materials. This 
procedure requires seven model materials to flush all of the channels in the 
print-block heater. 

6. Click Next.
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7. In the Cartridge Positioning screen, make sure that the material cartridges 
are properly positioned.

Figure 4-139    Cartridge Positioning screen
Symbols:

 The correct cartridge is in this slot.

 No cartridge (or the incorrect cartridge) is in this slot.

 The cartridge in this slot has insufficient weight to complete the material 
replacement process.

 The expiration date of the cartridge in this slot has passed.

Note: The time needed to complete this process depends on the materials 
currently loaded in the printer. The estimated time is displayed at the bottom 
of the Cartridge positioning screen.

8. Click Start.

9. Read the warning message, and click OK.
The wizard drains the model materials from the print block and fills it with 
the selected materials. 

When the process is finished, the Wizard Completed screen appears.

10. Click Done.
The printer-control application restarts, and it is now in High Mix / 
High Quality mode, using all seven material loaded in the printer.

Returning to the previous mode

To return to the High Speed or Super High Speed printing mode:

1. Run the Material Replacement wizard again.

2. In the Material Replacement Options screen, select the required printing 
mode and materials, and select the Economy flushing cycle.
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Figure 4-140    Material Replacement Options selection

3. Click Next.

4. In the Cartridge positioning screen, make sure that the material cartridges 
are properly positioned.

Note: The time needed to complete this process depends on the materials 
currently loaded in the printer. The estimated time is displayed at the bottom 
of the Cartridge positioning screen.

5. Click Start.
The wizard fills both channels of each print head with the selected material.

6. When the Wizard Completed screen appears, click Done.
After the printer-control application restarts, you can print.
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Replacing the Waste-Pump Tubes

The tubes that pump waste material from the roller waste collector and the 
purge unit should be replaced after 1000 hours of use. After this time, a counter 
displays a maintenance alert on the printer interface screen. 

Figure 4-141    Maintenance alert
You can check when the pump tubes need to be replaced in the Maintenance 
Counters interface. 

To open the Maintenance Counters interface:
➢  Click on the "Maintenance Required" indicator.
or—

➢  From the Options menu, select Maintenance Counters.

Figure 4-142    Selecting Maintenance Counters from the Options menu.
When the Maintenance Counters screen opens, scroll down to the General 
Pumps section.

Figure 4-143    Pump Maintenance Counters
The waste-pump tubes that require replacing are displayed in red.

Note:   If the check box on the right is selected, the "Maintenance Required" 
indicator appears when that task is due.
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To replace pump tubes, you replace the entire pump "cassette" in the printer. 
Replacement cassettes are supplied in the printer Start-up Kit. Additional 
cassettes can be ordered from your Stratasys service provider.

To replace the waste pump tubes:

1. Make sure that the printer is in Idle mode (see the figure on page 4-4).

Note:  The printer enters Idle mode about 16 minutes after printing stops. 
To force the printer into Idle mode, close the printer application: From the 
File menu, click Exit.

2. Using an 8-mm hex (Allen) key, open the two latches that secure the left 
printer panel (as you face the printer).

Figure 4-144    Opening a panel latch

3. Open the panel and disconnect the ground (earth) wire.

Figure 4-145    Ground wire connected to panel

4. Remove the panel.
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5. Identify the waste pump that requires tube replacement.

Figure 4-146    Waste pumps

6. Unscrew the fittings that connect the pump waste tubes, and separate the 
tubes.

Figure 4-147    Disconnecting pump tubes

7. Remove the part of the fitting remaining on the pump tube, and save it.
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8. Pull out the white restraining clip to release the pump.

Figure 4-148    Releasing the pump

9. When the tubes on both sides of the pump are disconnected, rotate the 
pump "cassette" counter-clockwise and remove it.

Figure 4-149    Rotating the pump cassette
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10. Holding a new pump cassette with one hand, gently pull on each of the 
tubes.
Pulling on the tubes before installing the cassette ensures that the pump 
mechanism turns freely.

Figure 4-150    Preparing the pump cassette for installation

11. Attach  the new pump cassette to the printer.
Fit the cassette into the slots in the housing, and turn clockwise to working 
position.

12. Connect the tubes to the new pump cassette.

13. If necessary, replace the pump cassette on the other waste pump.

14. Connect the ground wire to the printer panel. 

15. Attach the panel to the printer.

16. Open the Maintenance Counters screen, scroll down to the General Pumps 
section, and click Reset for the relevant counter(s) (see Figure 4-143 on 
page 4-96).
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Replacing the Material Filters

Filters are installed in the lines that supply model material  to the print heads. To 
ensure that the heads remain in optimum condition, the filters are replaced by 
your service provider, as part of the scheduled maintenance routine. However, 
filters used for certain materials need to be replaced more often. A counter 
keeps track of the amount of material passing through the filters, and the 
Maintenance Required indicator appears in the printer interface when it is time 
to replace a filter. The counter for RGD515 material, for example, is set to 
notify you after 20 hours of use. This is enough, on average, for about a year of 
printing.

To check the material-filter counters, open the Maintenance Counters screen 
(see "Maintenance Counters" on page 4-40) and scroll down to the Filters 
section.

Figure 4-151    Maintenance Counters screen, showing material filters
The figure above shows that 21 hours of filter time have passed since the left 
filter was installed, and that it needs to be replaced.

To replace the material filter:

1. Prepare the following tools and materials:
❒  8-mm hex (Allen) key
❒  protective gloves
❒  cleaning cloths or paper towels
❒  replacement 10-micron filters (supplied in the Start-up Kit)
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2. Close the printer application.

3. Shut down the printer computer, wait 60 seconds after the monitor goes 
blank, and turn off the main power switch.

Caution:
The monitor goes blank as soon as the remote desktop link terminates—
before computer shutdown. Turning off the printer before computer 
shutdown can cause damage.

4. Using an 8-mm hex (Allen) key, open the latches that secure the back of the 
materials cabinet and remove the back of the cabinet.

5. Locate the 10-micron filters, installed for the relevant material.

Figure 4-152    Material filters installed

6. Put on protective gloves.

Warning: Toxic and Corrosive Materials
Prolonged contact with resins could cause skin irritation. Put on protective 
gloves before continuing.

7. Disconnect the tube connected to the top (inlet) side of the material filter.

8. Make sure that the fitting at the end of the feed-tube remains attached to 
the tube. Re-attach it, if necessary. 

9. Cover the filter with a cleaning cloth (or paper towels) to absorb material 
spillage. 
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10. Identify the inlet side of the new filter. This is the side showing the part 
number. A 6mm tube is connected to the inlet. (An 8mm tube is connected 
to the outlet.)

 
Figure 4-153    Filter showing inlet and outlet sides

11. Attach the inlet side of the new filter to the disconnected tube.

Important:
To attach the filter, hold the fitting at the end of the feed tube in place and 
turn the filter. Otherwise, the tube will be twisted and material might leak.

12. Disconnect the old filter from the outlet (bottom) tube.

13. Discard the old filter.

Caution:
The filter contains uncured printing material. Discard the filter in accordance 
with applicable environmental regulations.

14. Attach the disconnected tube to the new filter. 

Important:
Before connecting the tube to the filter, turn the filter about 90°. When 
connecting them, hold the fitting at the end of the tube in place and turn the 
filter back to its original position. Otherwise, the tube will be twisted after you 
connect it, and material might leak.

15. Wipe the filters, tubes and surrounding area to remove material leaks and 
spills. 

16. Replace the back of the materials cabinet.
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17. In the Maintenance Counters screen, click Reset and then Close (see 
Figure 4-151 on page 4-101).

Replacing the Odor Filter

If the printer exhaust is not connected to an external ventilation system, a 
built-in activated-carbon filter removes odors from printing materials. This filter 
should be replaced regularly (as necessary) to keep your working environment 
pleasant. This is normally done during the preventive-maintenance service 
visit.

If the printer exhaust is connected to an external ventilation system, the 
odor filter is not needed and should be removed from the printer. 

Odor filter removal  improves heat expulsion and system cooling.

Replacing the UV Lamps

The UV lamps used for curing 3D prints have a long, but limited, working life. 
You can test and adjust their effective power with the UV Calibration wizard 
(see "Testing and Calibrating the UV Lamps" on page 4-82). If you need to 
replace a UV lamp bulb or UV reflector, follow these instructions: 

To replace the UV lamp bulb or UV reflector:

1. Make sure the printer is in offline mode.

Figure 4-154    Offline mode indicator (red)
The online/offline button at the bottom of the printer interface should be red. 
If not, click it to switch the printer to offline mode.

Warning
Before continuing, make sure that the safety interlock is not defeated, and 
that the UV lamp is not hot.
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2. Start the UV Lamp Replacement wizard from the Options menu. 

Figure 4-155    Selecting the UV Lamp Replacement wizard

3. Make sure that the build tray is empty, and confirm this in the wizard 
screen. Then, close the printer, and click Next.

Figure 4-156    Tray confirmation
The axes move to the “home” position.

4. Select the UV lamp(s) to be replaced and click Next.

Figure 4-157    UV lamp selection screen
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5. Disconnect the UV-lamp power connector and the UV heat fuse connector.

Figure 4-158    Disconnecting the UV lamp 

Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover up 
(B), then out (C).

Figure 4-159    Removing the UV lamp cover             
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7. Pull the UV reflector out of the UV housing.

Figure 4-160    Removing the UV lamp reflector

8. Using a 2.5-mm hex key, remove the UV lamp clamp (2 screws).

Figure 4-161    Removing the UV lamp clamp

9. Remove the UV lamp bulb from the UV reflector.

Figure 4-162    Removing the  UV lamp bulb
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10. Before continuing, inspect the spring-loaded pins. If there are burn marks 
around the pins or if the pins are loose—their springs are not functioning 
properly—and do not support the bulb, continue with step 15, to replace the 
UV reflector. 
Otherwise, continue with step 8 to replace the UV bulb.

Figure 4-163    Spring-loaded pin 

11. Using the polyurethane tube provided in the kit, push the new UV lamp bulb 
into the UV reflector. Make sure that the tip on the bulb is facing the slot.

Figure 4-164    Pushing the new UV bulb into the UV reflector
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12. Twist the tube by 180° (a), and continue to insert the UV lamp bulb into the 
UV reflector (b).

Figure 4-165    Twisting the tube and inserting the UV lamp

13. Use the UV lamp clamp to insert the lamp into place in the UV reflector.

Figure 4-166    Pushing the UV lamp into place

14. Using a 2.5-mm hex key, secure the clamp to the UV reflector, and continue 
with step 25.

Figure 4-167    Attaching the UV lamp clamp



Stratasys J850/J835 User Guide 4 Operating and Maintaining the Printer

DOC-18001 Rev. H 4-110

15. Inspect the new UV reflector, and make sure that a black strip is attached to 
the inside of it. If not, install one—on the side of the reflector opposite (not 
next to) the print block.

Note:  Extra black strips are included in the printer Start-Up Kit. If 
necessary, you can remove the black strip from the old reflector and install it 
in the new reflector (as long as the black paint has not faded).

16. Discard the old UV reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety 
requirements.

Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.
 l Ventilate the room thoroughly.
 l Use protective gloves when collecting mercury and lamp components.
 l Remove spilled mercury with a method that prevents the generation of 

mercury vapor, such as a syringe, packing tape or paper. 
 l Place the broken lamp, mercury and contaminated materials in an air-tight, 

non-metallic container.

17. Insert the UV reflector unit into the housing, next to the print block.

Figure 4-168    Print block and UV lamp assembly, showing correct 
placement of black strip
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18. Replace the UV lamp cover by inserting it into the slot on the bottom of the 
housing, and tighten the securing screw on top.

Figure 4-169    Replacing the UV lamp cover

19. Reconnect the power and heat fuse connectors.

Figure 4-170    Connecting the UV lamp
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20. In the wizard screen, confirm that you have replaced the UV lamp(s) and 
that the black strip is attached, then click Next.

Figure 4-171    UV-installation confirmation
The wizard operates the UV lamps and checks if their power is within the 
acceptable range for each printing mode. 

Note:   The mode currently being checked appears in the lower-left corner 
of the printer interface.

Figure 4-172    Status during UV lamp check
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After replacing a UV lamp, it is recommended that you calibrate its power 
for the various printing modes. The next screen allows you to continue to 
the UV Calibration wizard (see "Testing and Calibrating the UV Lamps" on 
page 4-82).

Figure 4-173    Calibration selection screen
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Improving Color Uniformity of X-Walls 

During the printing process, the alignment of the print heads can adversely 
affect the color uniformity of the part’s X-walls. The non-uniformity is more 
noticeable when the part’s left and right X-walls need to be matched after 
printing.

Figure 4-174    Color 3D print with matching walls

To achieve optimum color uniformity on left and right X-walls of the 3D print, 
after running the Head Alignment wizard, perform this wizard.

It is recommended to perform this wizard after replacing a print head. 

The correction performed by this wizard can be activated or deactivated 
before each print job, as needed.

Note: This wizard is not applicable for High Quality mode. 

In this procedure, you print a test transparency using the wizard, scan it on the 
digital scanner, load and analyze the scanned transparencies in an external 
Color Uniformity Utility, and enter the pixel correction values for each print 
head in this wizard.

To improve the color uniformity in 3D prints:

1. Prepare—
❒  disposable cleaning gloves (any clean, powder-free protective gloves)
❒  the  scanner 

Contact your Customer Support representative for the recommended 
scanner by Stratasys.

❒  a clean transparency (supplied in the Start-Up Kit)

Important: Do not use an unauthorized brand or type of transparency, 
as the results may not be accurate. 

❒  the grid transparency (supplied in the scanner accessories kit )
❒  one A4-sized sheet of black plastic (supplied in the scanner accessories 

kit)
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❒  Zyvax WaterShield™ for cleaning the transparency
❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
❒  a computer running GrabCAD Print (preferably the computer that sends 

print jobs to the printer)

❒  the Color Uniformity Utility (a MATLAB® Environment may also be 
required if not installed). 

Download this utility from the Software Dowload section on the 
Stratasys Support Center.

Important:   The scanner platen and transparencies used in this procedure 
must be absolutely clean, without scratches, fingerprints or other marks. If 
necessary, use a suitable glass cleaner and cleaning cloth, and always 
wear gloves when handling these items.

Printing a Transparency

1. Start the Color Uniformity wizard from the Options menu.

2. Click Next to begin.

3. In the following screen, continue as follows:
❒  To print a transparency sheet for analysis in the Color Uniformity Utility,  

select Print transparency and click Next.
❒  To enter correction values that you obtained from an earlier analysis 

without printing a transparency, select Enter correction values and 
click Next.

❒  To activate or deactivate the correction values that you have entered at 
an earlier time, select Activate/Deactivate uniformity correction and 
click Next.

Figure 4-175    Wizard process selection

4. Put on protective gloves.

5. Make sure that the build tray is empty and clean.

6. Place the blank transparency sheet flush against the rear and left edges of 
the tray (landscape orientation).

https://support.stratasys.com/en/resources/software-download
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Figure 4-176    Fixing the transparency to the tray

7. Secure the transparency sheet with tape to the tray.

8. Using a clean cloth, wipe Zyvax Watershield over the entire transparency. 
Continue wiping until the transparency is dry.

Figure 4-177    Cleaning the transparency with watershield

Important:   If you do not apply Zyvax Watershield, the scan may fail and 
result in Missing Nozzles error. Also, you may need to perform more 
iterations.
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9. In the following screen, confirm the items in the wizard screen, and click 
Next.

Figure 4-178    Confriming transparency readiness
A test pattern is printed on the transparency. This takes approximately 10 
minutes. 

10. When the printing is done, and click Next. 

11. When the following screen appears, continue as follows:
❒  To enter the correction values, select Enter the correction values 

now  and click Next. Continue below.
❒  To enter the values at a later time, select Exit wizard now. Enter 

correction values later  and click Next. The Wizard Complete screen 
appears. Click Done to exit.

Figure 4-179    Conitue or exit selection screen
This completes the first part of the  process.
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Scanning the Transparency
After printing the test pattern on a transparency, you scan it twice. In addition, 
you scan the reference (grid) transparency twice. 

Use the scanner currently recommended by Stratasys.

The illustrations in this section show the Canon CanoScan LiDE 400 
interface. 

If you need to install the software for this scanner, download it from: 
https://www.canon.co.uk/support/consumer_
products/products/scanners/lide_series/canoscan-lide-
400.html?type=drivers&language=&os=windows%2010%20(64-bit)

For convenience, the scanner should be connected to the computer running 
GrabCAD Print.

To scan the transparency:

1. On the computer connected to the scanner, open the scanner utility.

Figure 4-180    Scanner icon

2. In the opening screen, select ScanGear.

Figure 4-181    Scanning selection

https://www.canon.co.uk/support/consumer_products/products/scanners/lide_series/canoscan-lide-400.html?type=drivers&language=&os=windows%2010%20(64-bit)
https://www.canon.co.uk/support/consumer_products/products/scanners/lide_series/canoscan-lide-400.html?type=drivers&language=&os=windows%2010%20(64-bit)
https://www.canon.co.uk/support/consumer_products/products/scanners/lide_series/canoscan-lide-400.html?type=drivers&language=&os=windows%2010%20(64-bit)
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3. Select the Advanced Mode tab. 
4. Make sure that these settings are as follows:

❒  Color Mode: Color
❒  Output Resolution: 1200 dpi
❒  All field under Image Settings: None or OFF

Figure 4-182     Advanced Mode settings
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5. Place the test-pattern transparency face up on the scanner platen, with the 
arrows aligned with the black rail (under the glass), and the edge marked 
'This Face Up - A' along the bottom edge of the scanner glass (closest to 
you). 
Make sure that the bottom edge of the transparency is at the border of the 
platen.

Figure 4-183     Placing the transparency on the scanner - side A

6. Place the A4 sheet of black plastic, glossy-side down, on top of the 
transparency. Do not move the transparency.

7. Close the scanner lid.
8. At the bottom of the scanner interface, click Preview.

Figure 4-184    Scanner interface, showing Preview and Scan buttons
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9. With the cursor, adjust the cropping frame (scan area) so that it surrounds 
the printed pattern  shown below.

Figure 4-185    Adjusting the cropping frame (scan area)

10. Click Scan.
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11. When scanning is finished, select Scan other images in the dialog box 
and click OK.

Figure 4-186    Selection after scanning the test pattern

If this dialog box does not appear, click Preferences (at the bottom of the 
interface) and in the Scan tab, select Display the dialog to select next 
action.

12. Remove the transparency from the scanner, and place the reference (grid) 
transparency on the scanner platen, next to the bottom and left borders.
Note: Do not adjust the cropping frame (scan area). The scanning size 
must remain the same as for the test-pattern scan. 

13. Close the scanner lid.
14. Click Scan.
15. When scanning is finished, select Scan other images in the dialog box 

and click OK.
16. Place the test-pattern transparency face up on the scanner platen, with the 

edge marked 'This Face Up - B' along the bottom edge of the scanner 
glass (closest to you). See Figure 4-183 on page 4-120.
Make sure that the bottom edge of the transparency is at the border of the 
platen.

17. Place the A4 sheet of black plastic, glossy-side down, on top of the 
transparency. Do not move the transparency.

18. Close the scanner lid.
19. Repeat steps 8–14. 
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20. When scanning is finished, select Retouch and save the image in the 
dialog box and click OK.

Important: Save the images as JPG files.

Figure 4-187    Selection after scanning the reference transparency

21. Save the scanned files in a convenient folder on your computer. 
Next, you load these files to a dedicated utility for analysis.
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Analyzing the Transparencies
After scanning the test pattern and the reference grid, you analyze them in the 
Color Uniformity Utility, and the pixel correction values are calculated.

To analyze the scanned transparencies:

1. Open the Color Uniformity Utility installed on the GrabCAD Print computer.
2. Click Load Images and double-click one of the scanned images in the 

folder. You can select any one of the JPG images. Once you select an 
image, the utility uploads all four (4) JPG images of the scans you saved.

Figure 4-188    Color Uniformity Utility screen

3. Click Run to analyze the files.
4. When the analysis is complete, the results are displayed in the following 

screen. 

Figure 4-189    Enter Pixel Correction screen in utility
The results file is saved in the same folder as the scanned JPG files. This 
folder also contains a log file and the analysis of each scan. 
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5. On the printer, in the following wizard screen, enter each of the corrections 
values that appear in the  utility in the ¼ Pixel column.

Figure 4-190    Enter Pixel Correction screen in wizard

6. Click Next.
7. Save the corrections.
8. In the Wizard Completed screen, click Done.

Once the correction values are saved, a check mark appears near the 
wizard in the Wizards menu, as shown below. This indicates that the wizard 
is activated and the values are in use.

Figure 4-191    Color Uniformity wizard activated in the Wizards menu
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Dynamic Nozzle Test

Perform the Dynamic Nozzle Test if you suspect that poor quality in 3D prints is 
caused by clogged or faulty nozzles in the print heads—even if this is not 
indicated by the Pattern Test. 
The Dynamic Nozzle Test prints eight (8) samples on the build tray, which you 
can then visually inspect. Printing the samples takes about 20 minutes.

To run the Dynamic Nozzle Test:

1. Make sure that the build tray is clear (empty).

2. From the Options menu, select Dynamic Nozzle Test, and then select the 
appropriate test for the current printing mode.

Figure 4-192    Selecting Dynamic Nozzle Test from the Options menu

3. When the samples are printed, check if they have visible gaps.

…………
Figure 4-193    Dynamic Nozzle Test samples
❒  In the left sample shown above, there are no gaps. 
❒  In the right sample shown above, there are only two gaps, which is 

acceptable. 
Many gaps in the sample indicates that many nozzles in the print head are 
not functioning. This might indicate the need to replace the defective head. 
In this case, consult with your Stratasys service provider.

Samples printed from certain model materials in this test might not be 
completely cured. Because some of the material remains in liquid (or semi-
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liquid) state, you cannot check for gaps in these samples. Do not be 
concerned that liquid resin remains on and around these samples.
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Built-in Tests

The printer application contains a suite of tests for regularly checking the 
hardware and software, and for troubleshooting. 

Because running the tests affects the operation of the printer, you can only 
open the Built-in Tests interface when the system is not printing.

The test suite features:

• The organization of printing-related tasks in categories:
❒  Communications 
❒  Data cards 
❒  Temperatures 
❒  Voltages 
❒  Encoder repeatability 
❒  Print-head heating
❒  Print-head filling 

• A clear display of test results and the source of any failures, enabling you to 
determine if printing is possible or worthwhile. 

• The ability to monitor test results for specific components.

• Troubleshooting tips.
Running these tests can help identify problems in the printer hardware and 
software. A large number of hardware defects (or near-defects) warns you of 
possible printing problems, either for current or future jobs.

Stratasys recommends running the built-in tests in the following cases:
 l as a routine test, once every two weeks
 l as a system check, before major (long) jobs
 l as needed, for troubleshooting
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To open the Built-in Tests screen, do one of the following: 
• From the Options menu, select Built-In Tests.
• Press Ctrl+Alt+B.

Figure 4-194    Selecting Built-In Tests from the Options menu

 
The Built In Tests screen lists pre-configured tests, grouped by component 
categories. In this screen, you select and run tests, and the results are 
displayed.

Figure 4-195    Built In Tests screen    



Stratasys J850/J835 User Guide 4 Operating and Maintaining the Printer

DOC-18001 Rev. H 4-130

Test List

Test Name
This column lists all of the tests, together with selection check boxes. 

Click the check boxes to select the tests you want to run. To remove a 
selection, click the check box again. To quickly select all of the tests in a 
component category, use the Group drop-down list at the bottom of the screen.

Group
This column shows the component categories for each test. 

This tells you which tests are run when selecting a category from the Group 
drop-down list at the bottom of the screen.

Status
This column shows the results of each test after you run it:

Test successfully completed.

Test failed. (Double-click on a failed test’s line to review the failure details.)

Unknown results. (The test has not been run yet.)

Test Selection Area    
In the Test Selection area, at the bottom of the screen, you can quickly select 
or de-select tests by their characteristics:

All        Click to select all of the tests in the list.

None        Click to de-select all of the tests in the list.

Unknown        Click to select all test that have not been run yet (Status = ?).

Group        Use this menu to select tests by component category.

Selection Set        Use this menu to select a pre-configured set of tests to run at 
specified times (computer startup, before printing, etc.).

Running Built-in Tests

To run the selected tests:

➢  Click .

After you run a test, the Save and View command buttons are added to the 
Built In Tests screen.
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Test Results

To save and view a report of all tests:
➢  Use the Save and View command buttons.

Command Buttons

Click the command buttons, on the right side of the screen to perform the 
following operations:

Run
Click to run the selected tests.

Reset
Click to clear previously run tests. This returns the status of each test to 
Unknown (?).

Save
Click to save a report that summarizes the tests run. The report is saved as an 
HTML file. You can save any number of reports for the tests you run; the name 
of the file saved is BITReport [date][time].htm. By default, these files are 
saved in the printer installation folder, but you can save it in any other folder.

View
Click to display the latest test report that you saved. (You can view other test 
reports by opening the relevant files in your Web browser. To do so, open 
Windows Explorer, and double click the BITReport file.)
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Close
Click to close the Built-in Tests screen.

Summary

On the right side of the screen, a symbol represents the combined results of all 
the tests run, using the symbols from the Status column.

All tests successfully completed.

At least one test failed.

Not all tests performed.

Test Descriptions and Troubleshooting

The following table lists the name of each test in the Built-in Tests suite, 
together with its description and a possible reason for its failure. If you need 
assistance, contact your Stratasys service provider.

 

Test Name Description Possible Reason for Failure
FIFO Non-Interrupt/

FIFO Interrupt

• Tests the data queue in the 
DATA PCI card.

• Tests the Windows interrupt.

• If both FIFO tests fail: 
Faulty DATA_PCI card.

• If only the FIFO Interrupt test fails:
Faulty Windows interrupt.

System Info Compares the following parameter 
values with the minimum 
requirements.
• physical memory
• available memory
• free space on disk
• monitor resolution

Failure of RAM memory allocation in 
the printer computer.

Parameter Sanity 
Check

Compares the values of all printer 
parameters (in cfg files) to the 
required values.

One or more of the printer parameters 
is not within the required range. 
Details appear in the BIT report.

RFID Verifies the presence of RFID tags 
on material cartridges, and tests 
them (by writing data to the tag and 
then reading it).

• Faulty RFID reader.
• Faulty RFID reader power supply.
• Faulty or misaligned RFID tag.
• High level of electromagnetic 

noise around the RFID tag.

Sub-System 
Communications

Tests communication between 
printer components.

• Disconnected communications 
cable.

• Faulty cable.
Cabin Temperature Tests the temperature level in the 

build-tray area.
• Faulty temperature sensor 

(OHDB).
• Failure of exhaust fan.
• Clogged exhaust filter.
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Test Name Description Possible Reason for Failure
Head Voltages Checks the control of voltages 

supplied to the print heads.
Faulty print-head driver card(s).

Head/Block Heaters Tests the heaters in the print heads 
and in the print-block body.

Faulty heaters or thermistors.

System Voltages Checks if the following voltages are 
within 5% of the required voltage:
• 40V to the print heads by the 

VPP power supply
• 12V to the height thermistors by 

the VDD power supply

• VPP power supply: 
Faulty head driver.

• VDD power supply: 
Faulty height thermistor.

UV Lamps Tests each UV lamp at the High 
Quality power level.

• Faulty UV lamp.
• Faulty UV power supply.
• Disconnected UV cable.

Axes Limits Tests the hardware and software 
limits of all axes.

Faulty hardware sensors. 
Wrong Max Position parameter.

Block Filling Analyzes the thermistor readings 
when the block is full and when it is 
empty.

Faulty thermistor.

Encoder Steps Count Tests the encoder's reliability by 
comparing readings from multiple 
runs along the X-axis.

Misaligned or faulty encoder.

Vacuum Test Tests the vacuum level in the print 
block.

• Faulty vacuum sensor. 
• Vacuum leakage. 
• Wrong parameters.

Interlock Tests the interlock in the printer 
cover.

• Failure of interlock mechanism.
• Faulty latch. 
• Disconnected cable.

Version Tests Checks the compatibility between 
the software and component 
firmware versions.
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Replacing the Waste Container

Printer waste contains partially cured polymeric material, collected during 
normal operation and maintenance of the printer. For safety and environmental 
reasons, this material is kept in a special leak-proof, disposable container. 

The container has a capacity of 10 kilograms of waste material—usually 
enough for several months of printer use. The printer application displays a 
warning message when there are 9 kilograms of material in the container, and 
stops the printing when the net weight reaches 9.5 kilograms. Above 9 
kilograms, the software does not allow you to start a printing job or activity until 
you replace the waste container. 

You can monitor the weight of the waste container in the Printer Indicators 
display in the printer interface. You can also visually inspect the level of waste 
in the container. To access it, see page 4-135.

To monitor the waste weight (and other indicators) in the printer:
➢  In the main printer interface screen, click the display toggle to view the 

printer indicators.

Figure 4-196    Printer interface, showing waste weight (red background 
indicates operator alert)
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The waste container consists of a plastic container inside a cardboard box. 
You typically dispose of the entire waste container—including the box. 
Therefore, you must assemble a new box and insert a new plastic container 
before you can install it in the printer.

Replacement boxes, plastic containers, and sealing caps are supplied in 
the printer start-up kit and in the preventive-maintenance kit.

To prepare a new waste container:

1. Assemble the cardboard box, making sure to punch out the perforated 
sections.

2. Place a new plastic container into the box.

Note:  Do not close the box until you connect the waste drain tube from the 
printer.

To replace the waste container:

1. Locate the door on the lower-left side of the printer.

2. Push in the top-center of the door to release the latch and open the door.

Figure 4-197    Accessing the waste container

3. Carefully slide out the waste container to remove it from the printer.

4. Place the new waste container next to the full container.

5. Unscrew the cap securing the waste drain tube and connect it to the new 
container.

6. Close the full container with the cap supplied with the new waste container.

7. Close the new waste container box.
If necessary, use tape to hold it closed.

8. Position new the waste container in the printer.

Note:  Make sure that the waste drain tube is not crimped or twisted, and 
that it is not pinched by the container.
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9. Close the waste compartment door.

Dispose of the full waste container in accordance with environmental and 
safety requirements.

Cleaning the Exterior Panels

The painted exterior plastic panels of the printer has a durable finish, offering 
excellent chemical resistance to common cleaning materials. Follow the 
recommendations below when cleaning these areas of the printer. 

Acceptable Cleaning Agents
• mild soap solution 
• common household cleaners and window cleaners
• common commercial and industrial detergents, 5% solution in water 
• alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the cleaning 
solution.

Unacceptable Materials
• industrial solvents 
• cleaning agents containing hydrocarbons, ketones, esters and lacquer 

thinners
• spray disinfectants

• abrasives and agents which could wear away the panel finish

Cleaning the UV Screen

The transparent section of the cover is made of strong, acrylic material that 
screens out harmful UV radiation. Use extreme care when cleaning it to 
prevent the appearance of scratch marks.

Caution
Do not use abrasive cleaners or cleaning fluids containing ammonia, 
alcohol, acetone, benzine, carbon or tetrachloride. These materials can 
cause permanent damage to the surface.

To clean the UV screen:

1. Blow off surface dust.
Do not wipe the surface to remove dust; this might scratch the surface.

2. Prepare a 1-percent solution of mild dish-washing soap in water—about 
two teaspoons (10 ml) in a liter of water.
Note:   While soapy water is effective for cleaning, commercial products are also 
available for cleaning acrylic surfaces (for example, Novus® and Brillianize®).
These products give the surface antistatic, smudge and scratch-resistant 
properties.
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3. Soak a micro-fiber cloth in the solution.
Do not use paper towels, which can cause scratch marks.

4. Thoroughly wet the surface with the cloth. Do not wipe! 

5. Rinse the cloth with clean water. 

6. Absorb the solution from the acrylic surface with the cloth, without applying 
pressure.

7. If necessary, repeat to remove any remaining marks, or apply clean water 
to rinse the surface.

8. If the surface is still wet, you can dry it with a clean, micro-fiber cloth by 
gently wiping in one direction.

If convenient, you can apply the cleaning solution and water to the acrylic 
surfaces with a spray bottle instead of with the cloth.
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Removing 3D Prints After Printing

When printing is completed, you should allow the 3D prints to cool as much as 
possible before handling them. If additional 3D prints do not have to be 
produced on the printer, it is best to let the 3D prints cool in the printer, with the 
cover closed, as long as possible. 

If the printer must be used to produce additional 3D prints as soon as 
possible:

1. Let the 3D prints cool on the build tray for at least 10 minutes. 

2. Very carefully, remove the 3D prints from the tray with a scraper or spatula 
(supplied in the tool kit), taking care not to pry or bend the 3D prints.

Warning:
Wear protective gloves when handling 3D prints before they are washed.

3. Place the 3D prints on a flat surface, and cover them with a cardboard box 
or paper hood.
This allows them to cool slowly and evenly.

4. Let the 3D prints cool for several hours.

Removing the Support Material

After the 3D prints have cooled, the support material must be removed. This 
can be done by different methods, depending on the type of support material, 
the size of the 3D print, how delicate it is, the amount and location of the 
support material, and other factors. The methods described in this section refer 
to removing general-purpose support materials from 3D prints, for most 
printing applications. Use this information as a guide, and adapt the methods 
(or a combination of them) for cleaning your 3D prints.

For special printing applications, refer to documents on     the Stratasys 
Support Center  or consult a Stratasys 3D printing expert.

There are two types of support material available:

• SUP705 (FullCure705), a gel-like support material.

• SUP706, an easily removed support material that dissolves in a solution of 
caustic soda and sodium metasilicate.

https://support.stratasys.com/Knowledge
https://support.stratasys.com/Knowledge
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SUP705 (FullCure705) and SUP706 support material can be removed from 3D 
prints using the following methods, in this order:

1. by hand

2. water pressure (in a suitable cleaning unit)

3. SUP705: 1% caustic soda solution (recommended for a smooth finish)
SUP706: 2% caustic soda and sodium metasilicate solution

Removing Support by Hand

While wearing protective gloves, break away excess support material on the 
outside of the 3D print. For delicate 3D prints, use a toothpick, pin or small 
brush after dipping the 3D prints in water.

• For SUP705, after breaking away excess support material, soak the 3D 
print in a 1% caustic soda solution (see "Removing SUP705 with Caustic 
Soda" on page 5-4).

• For SUP706, after breaking away excess support material, soak the 3D 
print in a 2% caustic soda and sodium metasilicate solution (see "Removing 
SUP706 with Caustic Soda and Sodium Metasilicate" on the next page).

Removing Support with Water Pressure

For most 3D prints, the most efficient way to remove support material is by 
using a high-pressure water jet. One suitable system is the Balco WaterJet 
cleaning unit. This device is marketed by Stratasys.

Figure 5-1                     Balco WaterJet Cleaning Unit    
To clean a 3D print using this device, you manipulate it and the water using the 
built-in, waterproof sleeves. A pump turns ordinary tap water into a high-
pressure jet. A wiper keeps the window clear.

Use caution when cleaning delicate 3D prints with high-pressure water 
systems.
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Removing SUP705 with Caustic Soda

Soak 3D prints in a 1-percent solution of caustic soda (sodium hydroxide) to 
remove support material from difficult-to-reach areas and to give the 3D print a 
smooth, clean finish. The amount of time you soak the 3D prints in the solution 
depends on how delicate it is and how much support material needs to be 
removed, but it is typically between half-an-hour and several hours. In any 
case, you should remove as much support material as possible before the 
caustic soda treatment, and rinse the it thoroughly (with a water jet) afterwards. 

Warning
Caustic soda may cause chemical burns, scarring and blindness. Mixing it 
with water generates heat that could ignite other materials. Never pour 
water into caustic soda. When diluting the solution, always add caustic soda 
to water. Take adequate safety precautions; always use nitrile gloves when 
handling caustic soda and 3D prints soaked in it.

Removing SUP706 with Caustic Soda and Sodium Metasilicate

Soak 3D prints in a 2-percent solution of caustic soda (sodium hydroxide) and 
sodim metasilicate (Na2SiO3) to remove support material. The amount of time 
you soak the 3D prints in the solution depends on how delicate it is and how 
much support material needs to be removed. Rinse the 3D print thoroughly 
under running water afterwards. 

SUP706 will dissolve into the caustic soda and sodium metasilicate solution 
and saturate it, reducing its effectiveness. Replace the solution when the 
support material reaches 15% of the solution (after approximately one 
month of average use).

Warning
Caustic soda may cause chemical burns, scarring and blindness. Mixing it 
with water generates heat that could ignite other materials. Never pour 
water into caustic soda. When diluting the solution, always add caustic soda 
to water. Take adequate safety precautions; always use nitrile gloves when 
handling caustic soda and 3D prints soaked in it.
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Post-Printing Treatment

Post-printing treatment is recommended for 3D prints with several special-
purpose materials or for special applications. Recommendations for treating 
and finishing 3D prints after printing are described in the Best Practices for the 
desired printing material available on the Stratasys Support Center.

Photobleaching for Transparent 3D Prints 

3D prints fabricated with clear materials, such as VeroClear (RGD810) and 
VeroUltra Clear (RGD820) have a slight yellow tint when removed from the 
printer. This is especially true for 3D prints with a glossy finish. The yellow tint 
fades naturally over time, but you can greatly accelerate this process by using 
a suitable photobleaching treatment. This involves exposing 3D prints to 
intense light immediately after printing.

Photobleaching methods and instructions are described in the Best 
Practices for the relevant clear material. These are available on the 
Transparent materials page on the Stratasys Support Center. 

Refer to the Best Practices for: 
 l VeroClear RGD810
 l VeroUltra Clear RGD820

Storing 3D Prints

3D prints are cured as they are printed, making them safe and stable for a long 
time. However, proper storage conditions are necessary to prevent deforming.

• Keep 3D prints at room temperature and in a low-humidity environment.

• Do not expose 3D prints to direct sunlight and other heat sources.

https://support.stratasys.com/Knowledge
https://support.stratasys.com/materials/polyjet-materials/transparent
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